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Dear Customer, 
 
throughout this manual FSQ, FSU, FSP, ESPI, FSE, FSIQ and ESIB is generally used as an abbreviation for the instruments 
R&S FSQ, R&S FSU, R&S FSP, R&S FSEA, R&S FSEB, R&S FSEK, R&S FSEM, R&S ESPI, R&S FSIQ, and R&S ESIB. The 
Software for Phase Noise Measurement R&S FS-K4 is abbreviated as FS-K4. 
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Qualitätszertifikat

Sehr geehrter Kunde,

Sie haben sich für den Kauf eines Rohde &
Schwarz-Produktes entschieden. Hiermit
erhalten Sie ein nach modernsten Ferti-
gungsmethoden hergestelltes Produkt. Es
wurde nach den Regeln unseres Qualitäts-
managementsystems entwickelt, gefer-
tigt und geprüft. Das Rohde & Schwarz-
Qualitätsmanagementsystem ist u.a. nach
ISO 9001 und ISO14001 zertifiziert.

Certificate of quality

Dear Customer,

You have decided to buy a Rohde &
Schwarz product. You are thus assured of
receiving a product that is manufactured
using the most modern methods available.
This product was developed, manufac-
tured and tested in compliance with our
quality management system standards.
The Rohde & Schwarz quality manage-
ment system is certified according to stan-
dards such as ISO9001 and ISO14001.

Certificat de qualité

Cher client,

Vous avez choisi d'acheter un produit
Rohde & Schwarz. Vous disposez donc
d'un produit fabriqué d'après les métho-
des les plus avancées. Le développement,
la fabrication et les tests respectent nos
normes de gestion qualité. Le système de
gestion qualité de Rohde & Schwarz a été
homologué, entre autres, conformément
aux normes ISO 9001 et ISO14001.

Certified Quality System

ISO 9001
Certified Environmental System

ISO 14001
DQS REG. NO 1954 QM DQS REG. NO 1954 UM
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Support Center 
 
 

Telefon / Telephone: +49 (0)180 512 42 42 
 
Fax: +49 89 41 29 137 77 
 
E-mail: CustomerSupport@rohde-schwarz.com 

 

 
Für technische Fragen zu diesem Rohde & Schwarz-Gerät steht Ihnen 
die Hotline der Rohde & Schwarz Vertriebs-GmbH, Support Center, zur 
Verfügung.  
Unser Team bespricht mit Ihnen Ihre Fragen und sucht Lösungen für Ihre 
Probleme.  
Die Hotline ist Montag bis Freitag von 8.00 bis 17.00 Uhr MEZ besetzt.   
Bei Anfragen außerhalb der Geschäftszeiten hinterlassen Sie bitte eine 
Nachricht oder senden Sie eine Notiz per Fax oder E-Mail. Wir setzen 
uns dann baldmöglichst mit Ihnen in Verbindung. 

 

  
Um Ihr Gerät stets auf dem neuesten Stand zu halten, 
abonnieren Sie bitte Ihren persönlichen Newsletter unter  
http://www.rohde-schwarz.com/www/response.nsf/newsletterpreselection. 
Sie erhalten dann regelmäßig Informationen über Rohde & 
Schwarz-Produkte Ihrer Wahl, über Firmware-Erweiterungen, 
neue Teiber und Applikationsschriften.  

 
  

Should you have any technical questions concerning this Rohde & 
Schwarz product, please contact the hotline of Rohde & Schwarz 
Vertriebs-GmbH, Support Center.   
Our hotline team will answer your questions and find solutions to your 
problems.  
You can reach the hotline Monday through Friday from 8:00 until 17:00 
CET.  
If you need assistance outside office hours, please leave a message or 
send us a fax or e-mail. We will contact you as soon as possible. 

 

  
To keep your instrument always up to date, please subscribe 
to your personal newsletter at  
http://www.rohde-schwarz.com/www/response.nsf/newsletterpreselection. 

As a subscriber, you will receive information about your 
selection of Rohde & Schwarz products, about firmware 
extensions, new drivers and application notes on a regular 
basis.  

 

http://www.rohde-schwarz.com/www/response.nsf/newsletterpreselection
http://www.rohde-schwarz.com/www/response.nsf/newsletterpreselection
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1 Installation Instructions 

The following paragraphs describe how to install the FS-K4 software for phase noise measurement, and 
how to remove it.  

For a step-by-step introduction to using the product please see the section entitled “How to use FS-K4" 
in this manual, or on-line help. 

 
 

Installing FS-K4 on PCs 
FS-K4 is designed to work with Windows 9x (95, 98 and ME), Windows NT, Windows 2000 and 
Windows XP. Please make sure that one of these operating systems is installed before continuing. 
 
To control your Spectrum Analyzer from a PC using FS-K4, you must first install a GPIB interface card 
in your computer, and then connect the PC and Spectrum Analyzer using a GPIB Cable. FS-K4 
supports the following cards: 
 

Supplier Model 

Rohde & Schwarz PS-B4 model 04 

National Instruments PCII/IIA, AT-GPIB/TNT (PnP), AT-GPIB/TNT, PCI-GPIB, PCMCIA-GPIB 

 
Rohde & Schwarz cannot guarantee or provide support for FS-K4 when used with any other 
manufacturer's GPIB interface products. 

Before running FS-K4 please use the setup and self-test software, supplied with the card, to ensure that 
all driver settings are set to their default 'factory' condition, and that the board is functioning correctly. 
Please consult the documentation supplied with the card to learn how to do this. 
 
FS-K4 Software Setup 
To install FS-K4, proceed as follows: 
 
1. Start Microsoft Windows 

It is strongly recommended that you exit all Windows programs that may be running now. 
This includes anti-virus software, office suite toolbars, information management software, 
etc. If you want to check the Setup disks for viruses, do it now and then exit the anti-virus 
software. 

2. Insert the installation disk in drive A. 
3. Click the Start button, and then click Run. 
4. Type a:\setup and press ENTER. 

A message box will appear announcing that, “FS-K4 Setup is preparing the InstallShield® Wizard 
which will guide you through the rest of the setup process.” 

5. The Welcome screen will then appear, reminding you once again to exit all Windows programs in 
case they interfere with the Setup process. If necessary choose the Cancel button, exit any Windows 
programs, and go back to step 2. Otherwise, choose the Next button to continue. 

6. Setup will then ask where you want to install FS-K4. It will suggest a default location, but you may 
change this if required by choosing the Browse button and selecting a new destination. Choose the 
Next button to continue. 
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7. Setup will then copy files from the Setup Disks to your hard disk.  
Files are copied into the Windows System directory as well as the destination you selected for FS-
K4. Some of these files may already be present on your hard drive, in which case the Setup Disk's 
file is only copied if it is newer than the Hard Drive's file. During this process, three gauges will show: 
the progress of each file as it is copied, the progress of each disk, and how much space is available 
on the destination drive. 
Once all files have been copied, a new Start menu folder, called FS-K4, will be created containing 
the following shortcuts: 
 

 FS-K4 - runs the application 

 Help - displays the on-line help without running the application 

 

8. Finally, a message box will be displayed informing you that the installation is complete. Press the 
Finish button to exit Setup. 

9. Don’t forget to re-start your anti-virus software once installation is complete. 
 
 
 

Removing the Software 
If at any time you need to remove FS-K4 from your PC or Spectrum Analyzer, simply follow the 
instructions below. 
 
1. Start Microsoft Windows, 

2. Click Start, 

3. Point to Settings, 

4. Click to Control Panel, 

5. Double-click Add/Remove Programs, 

6. Select FS-K4 in the list of programs that can be automatically removed 

7. Click Add/Remove 

8. Follow the instructions presented by the UNinstallShield® Wizard. 
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Installing FS-K4 on FSIQ, ESIB and FSE with FSE-B15 
Option 
If your spectrum analyzer (FSIQ, ESIB or FSEx with FSE-B15) is suitably configured, no external PC will 
be required for phase noise measurements and your analyzer will constitute an independent phase 
noise test set.  

FS-K4 is designed to work with firmware version 2.x or higher. If your Spectrum Analyzer is fitted with an 
earlier version, please ask your Rohde & Schwarz representative to arrange for an upgrade. 

If you want to run FS-K4 on your FSE Spectrum Analyzer, you must have the FSE-B15 Computer 
Option fitted. If you do not already have this option, please ask your Rohde & Schwarz representative for 
details. 

The installation of the FS-K4 described below requires the administrator login. The user name is 
"Administrator", the password for the administrator login is 894129 for the instrument. 

On power-up following the installation under the administrator identification, the NT login window is 
displayed (no autologin). The user name entry is to be replaced by "instrument" and "instrument" as the 
according password. This change re-enables the autologin. 
 
 
FS-K4 Software Setup 
To install FS-K4 on the FSIQ, ESIB or FSE with FSE-B15 option proceed as follows: 
 
1. First connect the keyboard and mouse, and turn on the spectrum analyzer 
2. Wait until the spectrum analyzer has initialized 
3. Press the ALT and Print Screen/Sys Rq keys together. The analyzer display will switch to computer 

mode, showing the Windows screen 
4. Insert the installation disk in drive A. 
5. Now follow the same instructions as described in “Installing FS-K4 on PCs” sub-section “FS-K4 

Software Setup” from step 3. 

 

Note:  You can switch the display back to Spectrum Analyzer mode, by pressing ALT + Print 
Screen again. 
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Installing FS-K4 on FSQ, FSU, FSP or ESPI Analyzers 
running Windows NT 
If your FSQ, FSU, FSP or ESPI analyzer is suitably configured, no external PC will be required for phase 
noise measurements and your analyzer will constitute an independent phase noise test set.  
To install and operate the FS-K4 software a PS/2 keyboard is necessary e.g. PSP-Z2 (Order No. 
1091.4100.02). When using other type of keyboards without built-in roll-key it is recommended to 
connect a PS/2 mouse to the rear of the analyzer. Do not connect keyboard and mouse with the power 
switched on.  
Prior to the installation of FS-K4 the internal connections between FS-K4 and the analyzer must be 
ensured:  
• Installation of network card driver (with built-in option FSP-B16 this is already included in the 

installation of option) 

• Installation of TCP/IP network protocol  

• Installation of RSIB interface libraries.  

Note: The WINDOWS NT files required for the installation of network drivers, protocols and 
services are located in the "C:\I386" directory. 

 
 
Installation of the network card driver for analyzers without the LAN 
interface option 
The basic prerequisite for the installation of the TCP/IP protocol is that a network card driver is built in. 
In the absence of such a card a so-called loopback adapter takes over for the missing function. The 
adapter is part of the Windows NT.  
The installation procedure is as follows after the power-up of the analyzer and start of the firmware: 

 Open the start menu of Windows NT with the key combination <CTRL>-<ESC> . 

 Select menu items SETTINGS – CONTROL PANEL – NETWORK. 

 
 

 
 

 
 Answer the question  "Do you want to 
install it now?" with "Yes". 
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 Leave the presetting "Wired to the 
network" unchanged and confirm with 
"NEXT". 

 

 
 
 
 

 
 Choose a network card by clicking "Select 
from list". 

 

 

 
 
 

 
The OEM options appear. 

 Click MS Loopback Adapter and confirm 
with OK. 
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 If "Loopback“ has already been selected, 

this select box appears: 

 Confirm "MS Loopback Adapter" with 
"OK". 

 

 

 
 

 
 Leave dialog with "MS Loopback Adapter" 

selected using "NEXT". 
 

 
 
 
Installation of TCP/IP network protocol 
 

 
 

 
 Select TCP/IP protocol and confirm with 
"NEXT“. 

 

 
 
 
Selection of network services 

To be able to use the network resources it is necessary to install the corresponding services. 

Note: The network administrator knows which services are to be installed. 
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 The selected services cannot be changed 
when installing for the first time. 

 Further services may be added after the 
installation. 

 Continue with "NEXT“. 

 
 
 
Termination of the installation 
 

 
 
 

 
 Initiate installation by clicking "NEXT". 

 

 

 
 

 
 Enter drive "C:\I386" and click "Continue". 

 A message box for selecting the frame 
type is opened. 
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 Select Frame Type "802.3" and confirm 

with "Continue". 

The dialog for selecting the TCP/IP 
properties is opened. 

 
 
 

 
 Answer the question on the use of DHCP 

with "No". 

The TCP/IP protocol is now installed. 

 
 
 

 
 Do not change the selection of "Adapter". 

 Click "Specify an IP address". 

 Enter IP address "223 . 0 . 0 . 0" and 
Subnet Mask "254 . 255 . 0 . 2". 

 Leave dialog with OK. 

The Network Bindings display is opened. 

 

 

 
 Do not change the setting and leave 

dialog with "Next". 
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 Initiate the installation by clicking "Next". 

 

 

 
 

 
 The preset computer and workgroup 

names "ANALYZER" and 
"WORKGROUP" can be confirmed with 
"NEXT". 

 Note: 
The computer name in Windows network 
must be unambiguous. 

 

 

 
 

 
 Terminate installation by clicking "Finish". 
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 Answer the query  "You must shutdown..." 

with "No" since after the installation of the 
network driver the "Service Pack 5" from 
Windows NT must be installed again. 

 

  
 Close Control Panel by entering 

<ALT><F4>. 
 
 

 
 
Re-installation of Service Pack 

The installation of the Service Pack has to be repeated to avoid error messages "One or more services 
could not be started…" occurring during booting. 
 
 

 
 

 
 Open the start menu of Windows NT with 

the key combination <CTRL><ESC>. 

 Select item "RUN". 

The input field for the program to be 
executed appears. 
 

 

 
 

 
 Enter the command "C:\SP\SP5i386" 

conclude with OK. 

The installation of the Service Pack begins 
with the unpacking of the associated files. 
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 Answer the question on user license 

agreement with "Accept the License 
Agreement..."  
 

 Remove marking at "Backup files 
necessary..." and conclude with "Install". 

The files of the Service Pack are now 
installed. 
 
Note: 
Backup of the files replaced by the Service 
Pack is not required. 
 

 
 

 
Once the installation is complete the request 
for restarting the instrument appears.  

 Click the "Restart" button. 

The instrument carries out a restart. 

 

 
The installation of the network card driver is thus completed. Next, the FS-K4 software must be installed 
(see chapter "FS-K4 Software Setup on FSQ, FSU, FSP or ESPI"). 
 
 
 
 
 
Installation of the network driver for instruments with the LAN 
interface option 
If the FSP-B16 option is built into the instrument, the basic condition for operating the FS-K4 is already 
effective. What remains to do is to ensure that the TCP/IP protocol has a correct configuration: 
 
 
 

 
 Open the start menu of Windows NT with 

the key combination <CTRL>-<ESC>. 

 Select menu items SETTINGS – 
CONTROL PANEL – NETWORK. 
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 Select the tag "Protocols". 

 
The "Network Setup Wizard" appears. 
 

 Select "TCP/IP Protocol". 
 

 

 

 
 Leave the selection "Adapter" unchanged.

 Click "Specify an IP address". 

 Enter the IP Address and Subnet Mask 
assigned to the instrument. This address 
is given by the network administrator. 

 Leave dialog with OK. 

 
 
 
FS-K4 Software Setup 

 Insert the program diskette in drive A. 

 Open the Windows NT start menu with <CTRL><ESC> and select "RUN". 

 Enter the command "A:\SETUP" and terminate it with <ENTER> or by clicking "OK". 
The installation program of the FS-K4 is started and takes you through the subsequent installation. 

 Follow the installation instructions on the screen. 

 After the installation is completed, close the FS-K4 program group with <ALT><F4>. 

 Open the Windows NT Explorer (via the start menu, see above) and copy the files 
D:\R_S\INSTR\RSIB\RSIB.DLL and D:\R_S\INSTR\RSIB\RSIB32.DLL into the directory 
C:\WINNT\SYSTEM32. 

 Close the Windows NT Explorer with <ALT><F4>. 
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Starting FS-K4  

 Open the Windows NT start menu with <CTRL><ESC>. 

 Start FS-K4 by selecting the sequence PROGRAMS – FS-K4 – FS-K4 with the cursor or mouse 
(terminate entry with <ENTER> when using the cursor keys). 

 FS-K4 is started and its window is opened. 
   
Switchover of screen between FS-K4 and analyzer 

 Press the key combination <ALT><TAB>, if necessary several times, to select "R&S Analyzer Interface" 
or "FS-K4" 

   
Closing FS-K4  

 Select the Exit command from the File menu or press the key combination <ALT><F4>. 

Before the program is shut down, you are given the opportunity to save all settings including test results. 
If you would like to save, click the button Yes.  
Software FS-K4 is thus closed down. 
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Installing FS-K4 on FSQ, FSU, FSP or ESPI Analyzers 
running Windows XP 
To install and operate the FS-K4 software a PS/2 keyboard is necessary e.g. PSP-Z2 (Order No. 
1091.4100.02). When using other type of keyboards without built-in roll-key it is recommended to 
connect a PS/2 mouse to the rear of the analyzer. Do not connect keyboard and mouse with the power 
switched on. 

Prior to the installation of FS-K4 there are no additional steps necessary since the instruments are 
preconfigured to work with the FS-K4 software. 
 
 
 
FS-K4 Software Setup 

 Insert the program diskette in drive A. 

 Open the Windows XP start menu with <CTRL><ESC> and select "RUN". 

 Enter the command "A:\SETUP" and terminate it with <ENTER> or by clicking "OK". 
The installation program of the FS-K4 is started and takes you through the subsequent installation. 

 Follow the installation instructions on the screen. 

 After the installation is completed, close the FS-K4 program group with <ALT><F4>. 

 
 
 
Starting FS-K4  

 Open the Windows XP start menu with <CTRL><ESC>. 

 Start FS-K4 by selecting the sequence ALL PROGRAMS – FS-K4 – FS-K4 with the cursor or mouse 
(terminate entry with <ENTER> when using the cursor keys). 

 FS-K4 is started and its window is opened. 

 
 
 
Switchover of screen between FS-K4 and analyzer 

 Press the key combination <ALT><TAB>, if necessary several times, to select "R&S Analyzer Interface" 
or "FS-K4". 

 
 
 
Closing FS-K4  

 Select the Exit command from the File menu or press the key combination <ALT><F4>. 

Before the program is shut down, you are given the opportunity to save all settings including test results. 
If you would like to save, click the button Yes.  

Software FS-K4 is thus closed down. 
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2 How to Use FS-K4 

When measuring with FS-K4 there are three basic steps to work through: 
1. Creating an Analyzer Setup, i.e., defining the sweep parameters and, if required, the limit line (p23), 
2. Making a Measurement, i.e., performing the sweep, analyzing and storing the results (p27), 
3. Generating a Report (p29) 
 
 
 

Creating an Analyzer Setup 
A complete Analyzer Setup consists of the following components: 
1. Sweep Setup Defines how each measurement should be made such as signal frequency and 

level, offset start and stop frequencies, display reference level and range, and 
report configuration. 

2. Limit Line Defines the maximum allowed noise level for each frequency in the 
measurement band. 

In order to make a measurement you must have a Sweep Setup, however the Limit Line is optional. 
You can load these components using any combination of the following methods: 
1. Creating New Setup Files (p23) 
2. Loading an Existing File (p25) 

Once you have assembled and activated the necessary files in memory you can store the complete 
Analyzer Setup for later re-use, see Saving a File (p26). 
 
 
Creating New Setup Files 
Before starting to make measurements with FS-K4 you should build a library of setup files. Sweep Setup 
files are dependent on Limit Line files, so you should create them in the order shown below. 

1. Creating a New Limit Line (p23) 
2. Creating a New Sweep Setup (p24) 

Each Sweep Setup file will also contain an embedded copy of any Limit Line file that it uses. 

Note:  When measurement results are saved, copies of all the files used to make the 
measurement are stored in the result data file. In this way future examination of results will 
remain independent of any setup file modifications that occur after a measurement is made. 

 
 
Creating a New Limit Line 

To create a new limit line: 
1. Choose New (p31) from the file menu. 
2. Select Limit Line in the New box. 
3. If you want to base the new limit on an existing one, choose a file name in the Template box. To help 

you, the description of the selected file name is displayed in the Description box. 
4. Otherwise if want to create a new limit from scratch, choose none in the Template box. 
5. Choose the OK button to load the selected template and open the Limit Line (p39) editor. 
6. If you have chosen to work with a template file, it will be displayed in the editor. Otherwise, the editor 

will be empty. 
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7. First, enter a name for the new limit line in the Name box. This name is used to create the file name 
for the limit when stored to disk. Thus it is restricted to eight characters in length and may consist 
only of characters which may be used in a DOS file name. 

8. Now enter limit line samples into the Values table entry box. 
9. To enter a new frequency in the left hand column of the table, move the highlight to the correct cell 

and type the new value. To specify a unit of measurement, append Hz, kHz, MHz or GHz to the 
value. In each case, the first letter is sufficient in either upper or lower case. To accept the new value 
either click on the tick button, or press the TAB key, or press the ENTER key. To reject the new 
value and retain the old one either click on the cross button, or press the ESCAPE key. 

Note:  The ENTER and ESCAPE only behave as described above when the insertion point appears 
in the value entry box to the right of the tick button. Normally, the ENTER key corresponds to 
the highlighted button and the ESCAPE key corresponds to the Cancel button. 

1. To enter a new level in the right hand column, simply move to the correct row, type the value in 
dBc/Hz and accept it. There is no need to enter the unit of measurement. 

2. You must enter at least two samples in ascending order of frequency with the lowest frequency at the 
top of the table. The total number of samples entered is shown by the Samples field. 

3. If you enter an illegal or out-of-range value, a message will be displayed in the Status Bar (p54) 
showing the range of acceptable values 

4. If you did not load a template file, choose the Activate button to turn the limit line on. 
5. Finally, choose the OK button to confirm the new limit line. 
 

You can store the new limit line for later re-use, see Saving a File (p26). 
 
 
Creating a New Sweep Setup 

To create a new Sweep setup: 
1. Choose New (p31) from the file menu. 
2. Select Analyzer Setup in the New box. 
3. If you want to base the new setup on an existing one, choose a file name in the Template box. To 

help you, the description of the selected file name is displayed in the Description box. 
4. Otherwise if you want to create a new setup from scratch, choose none in the Template box 
5. Choose the OK button to load the selected template and open the Sweep Setup (p35) editor. 
6. If you have chosen to work with a template file, it will be displayed in the editor. Otherwise, the editor 

will be pre-set to the default setup for the current Analyzer type. 
7. First choose the Analyzer type and options with which the new setup will be used. This controls the 

range of frequencies that may be used, and the availability of FFT Filters.. 
8. Enter the frequency of the carrier you wish to measure in the Signal Frequency box. You can specify 

the unit by appending GHz, kHz, MHz or GHz. In each case, the first letter is sufficient in either upper 
or lower case. 

9. In the Signal Level box, enter the magnitude of the carrier in dBm. This value is used to set the 
analyzer reference level. 

10. If you do not know the precise frequency of the carrier you wish to measure, select the Verify Signal 
Frequency and Level box. This enables a search, within a defined frequency tolerance range relative 
to the specified Signal Frequency, for the carrier of greatest magnitude. The frequency and level of 
this carrier are then accurately measured. If the resultant level is less that the specified Signal Level 
less a defined Level Tolerance, the measurement is aborted. Otherwise, the resultant frequency is 
used in place of the specified Signal Frequency, and the measured level is used to set the analyzer 
reference level, overriding the value specified in the Signal Level box. 

11. If enabled, enter a value in the Frequency Tolerance box. This defines the offset, either side of the 
specified Signal Frequency, within which the carrier is guaranteed to be. FS-K4 will search for a 
carrier between Signal Frequency - Frequency Tolerance and Signal Frequency + Frequency 
Tolerance. 
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12. If enabled, enter a value in the Level Tolerance box. This defines the offset relative to the specified 
Signal Level above which the carrier is guaranteed to be. 

13. The Minimum Offset and Maximum Offset boxes allow you to select the range of frequencies to 
measure. Each contains a list of positive offsets from the carrier. The Maximum Offset must be 
greater than the Minimum Offset, and the Signal Frequency + Maximum Offset must be less than or 
equal to the maximum frequency of the analyzer. 

14. The Maximum Level and Level Range boxes refer to FS-K4’s Graph rather than the analyzer display. 
The Maximum Level is specified in dBc/Hz since the displayed data is normalized to the carrier level. 

15. The trace may be offset by a fixed number of dBs entered in the Trace Offset box. 
16. Optionally the trace may also be smoothed by calculating the average of samples in a sliding 

window, see Smoothing Window in Sweep Setup (p35) for details. 
17. Choose the Report button to display the Report Setup (p37) dialogue box. This allows you to set 

initial values for various report text fields, and select which elements of the report to include. Once 
these values are set, choose the OK button to accept any changes 

18. In special circumstances you can further optimize the measurement by modifying the parameters 
shown in the Advanced Sweep Setup (p37) dialogue box. To open this choose the Advanced button, 
then once new values have been set, choose the OK button to accept any changes. 

19. Choose the OK button in the Sweep Setup dialogue box to confirm the new Sweep setup. 
 
 

Loading an Existing File 
To load an existing file from disk: 
1. Choose Open (p31) from the file menu. 
2. If you wish to load a file from a default directory, as defined in the Default Paths (p48) dialogue box, 

check the Jump to default directories box. 
3. Otherwise, make sure that this box is unchecked. 
4. Select the type of file you wish to load in the List Files of Type box. 
5. If Jump to default directories is checked, FS-K4 will automatically display the contents of the chosen 

file type's default directory and you should skip steps 4 and 5. 
6. Select the drive containing the file you want to load in the Drives box. 
7. Select the directory containing the file you want to load in the Directories box. 
8. Type the name of the file you want to load in the File Description box or select it in the file list box 

below. 
9. Choose the OK button to confirm your selection and load the file. 
10. If loading the chosen file will affect any unsaved changes to the files in memory, FS-K4 will ask if you 

want to save the changes. You will be asked this question for each modified file, and if you decide to 
save a modified file the Save As (p32) dialogue box will be displayed. 

11. If there is measured data in memory and loading the chosen file will directly affect the way in which a 
measurement is made, FS-K4 will warn you that all measured data will be discarded. 

 
Exactly how the contents of memory gets changed depends on the type of file loaded as shown in the 
table below: 

File of Type Affected Memory Files 

Limit Line The selected limit line only. 

Analyzer Setup The Sweep Setup, and Limit Line are changed and any Result Data discarded. 

Result Data The Sweep Setup and Limit Line are changed and any Result Data discarded. Reference 
data if any, is loaded into the reference trace. Sweep Data is loaded into the main trace. 

 
If you have loaded a limit line, the file will be activated. 
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Saving a File 
There are two ways of saving a file to disk, namely Save and Save As. Which one you use depends on 
whether the file has previously been named or not. 
 
The exact contents of the saved file depends on its type as shown in the table below: 
  

File of Type Contents 

Limit Line The selected limit line only. 

Analyzer Setup The current Sweep Setup and any activated Limit Line. 

Result Data The Sweep, the Reference Trace if any, the current Sweep Setup and any activated Limit 
Line. 

 
 
Saving an Unnamed File 

To save a new file to disk: 
1. Choose Save As (p32) from the File menu. 
2. If you wish to save a file to a default directory, as defined in the Default Paths (p48) dialogue box, 

check the Jump to default directories box. 
3. Otherwise, make sure that this box is unchecked. 
4. Select the type of file you wish to save in the List Files of Type box. 
5. If Jump to default directories is checked, FS-K4 will automatically display the contents of the chosen 

file type's default directory and you should skip steps 4 and 5. 
6. Select the drive you want to save the file on in the drives box. 
7. Select the directory you want to save the file in with the Directories box. 
8. Type the name and description you want to save the file under in the File Description box or select an 

existing name from the file list box below. 
9. If you are saving a Limit Line, the file name will be set to that specified in the limit editor and you will 

not be able to modify it. However, you can still enter a description. 
10. Choose the OK button to confirm your selection and save the file. 
 
 
Saving a Named File 

To save a previously named file: 
1. Choose Save (p32) from the File menu. 
2. Select the type of file you wish to save in the File of Type box. To help you, the description of the file 

currently in memory is displayed in the Description box. 
3. Choose the OK button to confirm your selection and save the file using the existing name and 

description. 
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Making a Measurement 
Measuring with FS-K4 consists of three steps: 
1. Making a Sweep Measurement (p27) 
2. Using the Marker menu commands for Analyzing Sweep Results (p28) 
3. Storing the results for later re-use, as described in Saving a File (p26). 

In cases where the phase noise of the unit under test is comparable to the inherent phase noise of the 
analyzer, a two stage measurement may be used to improve the accuracy of the final result. 

To make a two stage measurement: 
1. First connect a reference source to the analyzer. 
2. Make a Sweep Measurement as described above. 
3. Choose Trace to Reference (p44) from the Sweep menu to copy the trace into the reference buffer. 
4. Now connect the unit under test. 
5. Make a second Sweep Measurement. 
6. Choose Corrected (p41) from the View menu. 
7. The application will perform a linear subtraction of the reference trace from the uncorrected trace, 

and plot the result. 

Once a two stage measurement is complete you can 
• Switch back to the uncorrected trace by choosing Uncorrected (p41) from the View menu. 
• Display the reference trace by choosing Reference (p41) from the View menu. The Normal and Delta 

marker displays will change to include calculated level offsets from the marker level to the reference 
trace. 

To stop using the Reference Trace: 
• Choose Clear Reference (p44) in the Sweep menu. 
 
 

Making a Sweep Measurement 
To run a Sweep: 
• Choose Start (p43) from the Sweep menu. 
The Analyzer will be configured according to the current Analyzer Setup. If this fails, an information 
dialogue will be displayed describing the problem and the measurement will be aborted. 
If the Verify Frequency and Level function is selected in the Sweep Setup (p35) dialogue box, FS-K4 will 
then check to see if there is a Signal within the specified Frequency and Level Tolerance ranges relative 
to the specified Signal Frequency and Level. If no Signal is found, or a Signal is found, which is outside 
the tolerance range, an information dialogue will be displayed describing the problem, and the 
measurement will be aborted. 
After a short delay the Analyzer will start measuring and automatically uploading the Sweep results to 
the computer. The Status Bar (p54) message changes to read "Sweep running...(0%)", and as data is 
received the value inside the parentheses is updated to show the ratio of samples received to the total 
expected, expressed as a percentage. 
The overall sweep is divided into a number of sub-bands, which are measured separately. This is 
optimized to provide the best combination of measurement accuracy and speed. 
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If the Graph is visible, data will be plotted as soon as it is received. In many cases, the Sweep will 
generate more samples than can be displayed. A data reduction algorithm is used to ensure that the 
level represented by each pixel column in the displayed trace represents the maximum value measured 
for the band of frequencies it represents. This data reduction process does not affect the raw data 
uploaded from the Analyzer; which may be viewed, once the sweep is complete, by zooming in until 
every pixel column represents a single raw data sample. FS-K4 can store up to 20,000 samples in 
memory.  
If the RF Overload warning is activated whilst measuring a sub-band, the input attenuation will be 
increased by 10dB and the sub-band will be re-measured. 
If the sweep cannot be completed for any reason, an information dialogue will be displayed describing 
the problem and the measurement will be aborted. 

Whilst the sweep is in progress you can: 
1. Use the Normal (p45) and Delta (p45) Markers. These may be turned on using the commands in the 

Marker menu and moved along the trace using either the keyboard cursor keys, or by positioning the 
mouse pointer and then clicking the left mouse button. 

2. Abort the sweep by choosing Stop (p43) from the Sweep menu. An information dialogue will be 
displayed confirming this action and the measurement will be aborted. 

 
 

Analyzing Sweep Results 
The Marker menu provides a number of tools to help you examine the phase noise trace.  
1. The Normal (p45) marker displays the phase noise level measured at a specific frequency. 
2. The Delta (p45) marker displays the offset frequency and level relative to the Normal marker. 
3. When the Delta marker is enabled, Next Marker (p45) allows you to select which marker’s frequency 

may be varied using the mouse and/or cursor keys. 
4. Use the Measure at Marker (p45) command in the Marker menu to re-measure phase noise at the 

current marker frequency. 
5. The Zoom function allows you to view the Sweep results in greater detail, ultimately removing the 

effects of data compression so that the raw data is displayed.  
If the marker is in Normal mode, the Zoom In (p45) command will redraw the Graph, changing the 
frequency span to show one tenth of the previous span, centered on the marker frequency. Zoom In 
may be used repeatedly until only raw data is displayed, with no data reduction. Zoom Out (p46) has 
the opposite effect, increasing the span by a factor of ten centered on the marker, whilst 
Original Diagram (p46) returns the display to the span defined by the Sweep Setup. 
When the marker is in Delta mode, Zoom In changes the span to show frequencies between the 
reference and delta markers. 

 
In addition, the View menu provides three extra commands for displaying calculated values for Residual 
Phase Modulation, Residual Frequency Modulation, and RMS Jitter respectively. When the Delta 
marker is enabled, the calculation is performed on the measured values lying between the two markers. 
Otherwise, all measured values are taken into account. 
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Generating a Report 
There a three steps to consider when generating a measurement report: 
1. Setting up the Printer (p29) 
2. Previewing a Report (p29) 
3. Printing a Report (p30) 
 

You can store the Result Data for later re-use, see Saving a File (p26). 
 
 
 
Setting up the Printer 
To setup the printer: 
1. Choose Print Setup (p34) from the File menu. 
2. Select the output device you want to use in the Printer box. 
3. In the orientation box, select Portrait. 
4. FS-K4 is designed to print reports in portrait mode. Use of other formats may lead to unpredictable 

results. 
5. If you are using an HP Laser Jet type printer, choose the Options button to display the Options 

dialogue box. Select Line Art in the Dithering box then choose the OK button to accept the changes. 
Finally choose the OK button in Print Setup to accept the changes. 

 

Note:  Some drivers such as the HP Plotter cannot be selected from FS-K4. In this case you 
should use the Printer Setup command in Print Manager's Options menu. 

 
 
Previewing a Report 
To preview a report before printing: 
1. Choose Print Preview (p33) from the File menu. 
2. The Print Preview window will appear showing how a report would appear with the current report 

setup and measurement results. 
3. To view the following page, choose the Next button. 
4. Choose the Previous button to go back one page. 
5. To change the report setup choose the Setup button. 
6. The Preview Setup (p33) dialogue will be displayed allowing you to customize the report for the 

current unit under test. For example, you may enter the Make, Model, and Serial Number. When you 
save your measurement results, these changes will be saved in the Result Data file. However, they 
will not affect the Sweep Setup, so when you start a new Sweep measurement, any changes made 
here will be lost. If you want to make permanent changes, use the Sweep Setup editor and then save 
the Analyzer Setup. 

7. Choose Print to send the report to a printer. 
8. Choose the Close button to exit the Print Preview window. 
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Printing a Report 
To print a report without using Print Preview : 
• Choose Print (p34) from the File menu. 

The "Printing in progress" message box will appear containing a small picture of a printer, a page 
counter, and a Cancel button. As the print job progresses, sheets of paper will appear to feed 
through the printer and the counter will increment. 
If Print Manager is enabled, FS-K4 will print the Test Report immediately and Print Manager will 
handle any problems with the printer. 
Otherwise, the speed of report generation will be governed by the printer and Windows will handle 
any problems directly. 
Choosing the Cancel button will abort the report generation process, however you may have to clear 
the Print Manager or printer buffer. 
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3 Menu Commands 

This chapter describes all menu commands and their dialogue boxes. The menus are arranged as in 
the menu bar (p53).  
 
 

File Menu 
The File menu comprises the commands used for creating, opening, saving, printing files and for exiting 
FS-K4. 
 
 
New command (File Menu) 
Use this command to create new Analyzer Setups, and Limit Lines, or to load an existing Analyzer Setup 
prior to making a new measurement. In each case you can select a template file on which to base the 
new file or measurement. You can open an existing file with the Open (p31) command. 
 
Dialogue Box Options 

New 
Select the type of new file you want to create. 
Measurement Loads a Analyzer Setup and prepares for a new Sweep. 
Analyzer Setup Loads a template file and opens the Analyzer Setup editor. 
Limit Line Loads a template file and opens the Limit Line editor. 

Use Template 
Select the name of the template file you want to use for the new file or measurement. FS-K4 
lists template files, which are stored at the locations defined in the Default Paths (p48) dialogue 
box, and stored in your FS-K4.INI file. If you select none as the template for a new Limit file, the 
editor will be empty. On selecting none for a new Analyzer Setup, the editor will be filled with the 
default settings for the Analyzer.  

Description 
Whenever a file is saved, a long description may be entered at the right hand side of the File 
Description box in the Save As dialogue box. This information is read from the template file you 
select in the Use Template box and displayed in the Description box. 
 
 

Open command (File Menu) 
Use this command to open an existing Analyzer Setup, Limit Line, or Result Data file. You can create 
new files with the New (p31) command. 
 
Dialogue Box Options 

File Description 
Type or select the filename you want to open. This box lists file names and descriptions of the 
files with the extension you select in the List Files of Type box. 

List Files of Type 
Select the type of file you want to open. 
Analyzer Setup Lists all the files 

(*.set) saved with the .SET extension. 
Result Data Lists all the files 
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(*.dat) saved with the .DAT extension. 
Limit Line Lists all the files 

(*.lim) saved with the .LIM extension. 

Note: See Jump to default directories below. 

Drives 
Select the drive on which FS-K4 stores the file that you want to open. 

Directories 
Select the directory in which FS-K4 stores the file you want to open. 

Jump to default directories 
Enables automatic setting of the default drive and path each time you change to a different file 
type using the List Files of Type box. 
 
 

Save command (File Menu) 
Use this command to save an active file with its current name and description. When you save a new 
file for the first time, FS-K4 displays the Save As dialogue box so you can name the file. If you want to 
change the name or description of an existing file before you save it, choose the Save As (p32) 
command. 
 
Dialogue Box Options 

File of Type 
Select the type of file you want to save. 
Analyzer Setup Saves the current Analyzer Setup file. 
Result Data Saves the current Result Data file. 
Limit Line Saves the current Limit Line file. 

Description 
Whenever a file is saved, a long description may be entered at the right hand side of the File 
Description box in the Save As dialogue box. This information for current file, of the type you 
select in the File of Type box, is displayed in the Description box. 
 
 

Save As command (File Menu) 
Use this command to save, name and describe the active file of a specified data type. 

Note: To save a file with its existing name and description, use the Save (p32) command. 
 
Dialogue Box Options 

File Description 
Type a new filename in the left hand box to save a file with a different name. 
Use the current name, or select a name in the list to save a file with an existing filename. 
A filename can contain up to eight characters and an extension of up to three characters. FS-K4 
adds the extension for the data type you specify in the List Files of Type box. Filenames for Limit 
files must be defined using the corresponding editor and cannot be modified by the Save As 
dialogue box. 
Type a new file description or modify an existing one in the right hand side of the box. 

List Files of Type 
Select the type of file you want to open. 
Analyzer Setup Lists all the files 
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(*.set) saved with the .SET extension. 
Result Data Lists all the files 

(*.dat) saved with the .DAT extension. 
Limit Line Lists all the files 

(*.lim) saved with the .LIM extension. 

Note: See Jump to default directories below. 

Drives 
Select the drive on which FS-K4 will store the file that you want to save. 

Directories 
Select the directory in which FS-K4 will store the file you want to save. 

Jump to default directories 
Enables automatic setting of the default drive and path each time you change to a different file 
type using the List Files of Type box. 
 
 

Print Preview command (File Menu) 
Use this command to display the print preview window, with which you can see how a report will look 
when you print it. FS-K4 displays each page in a reduced size. You can customize the report for the 
current unit under test, see Preview Setup (p33) dialogue box for more information. 
 
To preview a report before printing 
1. From the File menu, choose Print Preview (ALT, F, V). 
2. FS-K4 displays the first page of the report. 
3. To customize the report for the current unit under test, choose the Setup (ALT, S) button. 
4. To view different pages in the report, use the Previous (ALT, P) and Next (ALT, N) buttons. 
5. To print the report use the Print (ALT, R) button. 
6. After viewing the report in print preview, you can close the print preview window by choosing the 

Close (ALT, C) button or pressing the ESCAPE key. 
 
 
Preview Setup command (File Menu) 
Use this dialogue to customize the report text and configuration for the current Unit Under Test. 
 
Dialogue Box Options 

Heading, ..., Comment 2 
Type report text as required. 

Titles 
Includes the above text fields in the report. If the result data has been stored to a disk file, the 
file name and description will also be included. 

Setup 
Includes the Sweep Setup information in the report. 

Date 
Includes the time and date at which the last measurement was made in the report. 

Markers 
Includes the Normal and Delta Markers, if they are turned on in the main display. 



Menu Commands  FS-K4 

1108.0107.42 34 E-6 

Print command (File Menu) 
Use this command to print reports. To specify a printer and its connection, use the Print Setup (p34) 
command in the File menu. Alternatively you can use the Printer Setup command in the Options menu 
of Print Manager. See your Windows documentation for more information. 
 
 
Print Setup command (File menu) 
Use this command to select a printer and connection, and specify printer settings. The settings you 
select become the default settings. 
 
Dialogue Box Options 

Printer 
Select the printer you want to use. 
Default Printer Uses the current default system printer. 
Specific Printer Uses a printer selected from the list of installed devices. 

Note:  You install printers and configure ports through the Windows Control Panel. For 
information on installing printers, see your system documentation. 

Orientation 
Select the page orientation, Portrait or Landscape, that you want for printing. 
With Portrait, the page is taller than it is wide when you view the printed document upright (the 
document prints lengthways on the page). With Landscape, the page is wider than it is tall when 
you view the printed document upright (the document prints sidewise on the page). 

Paper 
Select the size and source of paper you want to use. 
Size Open the list and then select the size of paper you want to use. 
Source Open the list, and then select the paper source you want to use. 

Options 
Choose this button to display the Options dialogue box, which contains additional options 
specific to the printer you select in the Printer box.  
For more information, open the Options dialogue and select the Help command button. 
 
 

Exit command (File Menu) 
Use this command to end your FS-K4 session. You can also use the Close command on the application 
Control menu. FS-K4 prompts you to save files with unsaved changes. 
 
Shortcuts 

 
Mouse: Double-click the application Control-menu button. 

  
Keys: ALT+F4 
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Edit Menu 
The Edit menu comprises the commands used for defining the analyzer setup parameters (sweep 
parameters) and the limit lines. The purpose of these settings is outlined in section „Creating an 
Analyzer Setup“ on page 23. 
 
 
Sweep Setup command (Edit Menu) 
Use this command to modify Analyzer Setup parameters. 

Note:  Changes that affect the validity of displayed results will cause the measurement buffers to 
be cleared. In this case a warning message will be displayed when the OK button is 
chosen. 

 
 
Dialogue Box Options 

Analyzer  

Model 
Select the type of Analyzer that this setup will be used with. This determines the range of 
frequencies that are available. 

FSE-B2 
Select this box if the setup will be used with an Analyzer equipped with the FSE-B2 7GHz 
Frequency Extension option. This box is only enabled for the following Analyzer models: FSEA 
20, FSEA 30 and FSIQ 3. 

FSE-B4 
Select this box if the setup will be used with an Analyzer equipped with the FSE-B4 Low Phase 
Noise and OCXO option. This box is only enabled for the following Analyzer models: FSEA 20, 
FSEB 20, FSEM 20, and FSEK 20. 

FSE-B5 
Select this box if the setup will be used with an Analyzer equipped with the FSE-B5 FFT 
Bandwidths option. This box is only enabled for the following Analyzer models: FSEA 20, FSEB 
20, FSEM 20, and FSEK 20. 

Signal 

Frequency 
Enter the frequency of the carrier whose phase noise you wish to measure.  
Specify the unit by appending GHz, kHz, MHz or GHz. In each case, the first letter is sufficient in 
either upper or lower case. 

Level 
Magnitude of carrier in dBm. 

Verify Frequency 
Enables a search, across a frequency tolerance range, for the carrier of greatest magnitude. 
Resultant carrier frequency and level are measured. If the level is within a level tolerance range, 
the measured values override the specified Signal Frequency and Level. Otherwise the 
measurement is aborted. 
This should be used when carrier frequency is not known precisely and when a very small 
Minimum Offset is used. 
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Frequency Tolerance 
Range, either side of Signal Frequency, within which the carrier is known to be. 
Specify unit as for Frequency. 

Level Tolerance 
Offset relative to Signal Level above which the carrier is know to be. 

Display 

X-Axis 

Minimum Offset 
Select the offset at which to start the sweep. 

Maximum Offset 
Select the offset at which to finish the sweep. 

Y-Axis 

Maximum Level 
Enter the value you want at the upper extent of the Graph’s level axis. Phase Noise levels are 
normalized to the carrier level and expressed in dBc/Hz. 

Level Range 
Enter the range of values you want for the Graph’s level axis in dB. 

Tools 

Trace Offset 
Enter any fixed offset in dB. This value will be added to each measured value. 

Smoothing Window 
The trace may be smoothed by calculating the linear average of sample values in a sliding 
window. Enter the width of the window as a number of samples.  
The width must be a positive, odd, integer, less than 200, i.e. 0 < n < 200, n mod 2 = 1. The 
default value of 1 turns smoothing off. 
The smoothing algorithm used is as follows: 
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Where: s = the trace sample number, y(s) = the phase noise at sample s, x = the sample offset 
from s, and n = the width of the sliding window. When x exceeds the boundary samples, the 
boundary sample is used, i.e. if the trace has samples numbering 0 to 500 then with n = 5 and s 
= 0 the average is calculated as: 
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Report 
Opens the Report Setup (p37) dialogue box. 

Advanced 
Opens the Advanced Sweep Setup (p37) dialogue box. 
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Report Setup 

Use this dialogue to define those parts of the report text which are independent of the Unit Under Test 
and to select the default report configuration. 
 
Dialogue Box Options 

Heading, ..., Comment 2 
Type report text as required. 

Titles 
Includes the above text fields in the report. If the result data has been stored to a disk file, the 
file name and description will also be included. 

Setup 
Includes the Sweep Setup information in the report. 

Date 
Includes the time and date at which the last measurement was made in the report. 

Markers 
Includes the Normal and Delta Markers, if they are turned on in the main display. 
 
 

Advanced Sweep Setup 

FS-K4 measures each decade of offset from the carrier in a separate sweep. Some decades are further 
split into sub-bands to allow optimum use of resolution filter and main PLL bandwidths. Use this 
dialogue to modify the Resolution Filter Bandwidths for each sub-band. In addition you can set the 
number of averaging sweeps made for each sub-band, and for analyzers equipped with FFT filters you 
can choose between FFT or normal filters for each sub-band. 
 
Dialogue Box Options 

Settings 
See Using Table Entry Boxes (p61) for detailed information about using this control. 

From 
This column lists the start frequency of each sub-band 

To 
This column lists the stop frequency of each sub-band 

Resolution BW 
This column lists the Resolution Filter Bandwidth used for each sub-band. Enter values between 
1 Hz and 3 MHz in steps of 1, 2, 3 and 5. You can specify the unit by appending GHz, kHz, MHz 
or GHz. In each case, the first letter is sufficient in either upper or lower case. 

Note: FSQ, FSU, FSP and ESPI accept values between 10Hz and 10MHz using analogue 
filters, and between 1Hz and 30kHz using FFT filters, FSP and ESPI in steps of 1 and 3. 

Sweep Count 
This column lists the number of sweeps to average over for each sub-band. Values must be 
integer, greater than zero, and odd. Default is 1. 
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Use FFT Filter 
This column only appears when FS-K4 detects an analyzer supporting FFT filters, or when there 
is no analyzer attached to your PC. It allows you to choose whether to use the FFT Resolution 
Filter or the conventional filter for each decade. 
When you enable FFT Filters for the decades starting at 10 Hz and 100 Hz, the entire decade is 
measured in one sweep. Accordingly the three sub bands used with normal filters are replaced 
with a single sub band. The Resolution Filter Bandwidth used is fixed for each sub-band, and 
cannot be modified. 

Default 
Select this button to return all settings to the following default values: 

FSEx 20 

From To Resolution BW Sweep Count Use FFT Filter 

10 Hz 20 Hz 2 Hz 1 Off 

20 Hz 40 Hz 5 Hz 1 Off 

40 Hz 100 Hz 10 Hz 1 Off 

100 Hz 200 Hz 20 Hz 1 Off 

200 Hz 400 Hz 50 Hz 1 Off 

400 Hz 1 kHz 100 Hz 1 Off 

1 kHz 10 kHz 200 Hz 1 Off 

10 kHz 30 kHz 500 Hz 1 Off 

30 kHz 100 kHz 3 kHz 1 Off 

100 kHz 1 MHz 3 kHz 1 Off 

1 MHz 10 MHz 30 kHz 1 not available 

10 MHz 100 MHz 300 kHz 1 not available 

100 MHz 1 GHz 3 MHz 1 not available 

1 GHz 10 GHz 3 MHz 1 not available 

FSQ x, FSU x, FSP x, ESPI x 

From To Resolution BW Sweep Count Use FFT Filter 

3Hz 10Hz 1Hz 1 On 

10Hz 30Hz 1Hz 1 On 

30Hz 100Hz 10Hz 1 On 

100Hz 300Hz 10Hz 1 On 

300Hz 1kHz 100Hz 1 On 

1kHz 3kHz 100Hz 1 On 

3kHz 10kHz 300Hz 1 On 

10kHz 30kHz 300Hz 1 On 

30kHz 100kHz 3kHz 1 Off 

100kHz 300kHz 10kHz 1 Off 

300kHz 1MHz 30kHz 1 Off 

1MHz 10MHz 30kHz 1 Off 

10MHz 100MHz 300kHz 1 not available 

100MHz 1GHz 3MHz 1 not available 

1GHz 10GHz 10MHz 1 not available 
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FSEx 30, FSIQ x, ESIB x 

From To Resolution BW Sweep Count Use FFT Filter 

10 Hz 20 Hz 2 Hz 1 Off 

20 Hz 40 Hz 5 Hz 1 Off 

40 Hz 100 Hz 10 Hz 1 Off 

100 Hz 200 Hz 20 Hz 1 Off 

200 Hz 400 Hz 50 Hz 1 Off 

400 Hz 1 kHz 100 Hz 1 Off 

1 kHz 10 kHz 200 Hz 1 Off 

10 kHz 60 kHz 500 Hz 1 Off 

60 kHz 100 kHz 500 Hz 1 Off 

100 kHz 200 kHz 3 kHz 1 Off 

200 kHz 1 MHz 3 kHz 1 Off 

1 MHz 10 MHz 30 kHz 1 not available 

10 MHz 100 MHz 300 kHz 1 not available 

100 MHz 1 GHz 3 MHz 1 not available 

1 GHz 10 GHz 3 MHz 1 not available 

RBW/VBW Ratio 
Select the ratio of Resolution Filter Bandwidth to Video Filter bandwidth. The default value is 
10-to-1, but you can also select 1-to-1, or 1-to-10 in special circumstances. 
 
 

Limit Line command (Edit Menu) 
Use this command to create and modify and activate Limit Line files. 
 
Dialogue Box Options 

Name 
Type a name for the limit line. 
This name will be used to identify the limit line when plotted on the Graph and when it is stored 
on disk or downloaded to a Analyzer. It may be up to eight characters long and can use any 
combination of the following: A..Z a..z 0..9 and _. 

Values 
Use this box to enter the limit line definition. This box has two columns for sample frequency 
and level respectively. Frequencies must be entered in order of magnitude with the lowest value 
at the top of the list. You can specify the unit by appending  Hz,  kHz,  MHz or  GHz. In each 
case, the first letter is sufficient in either upper or lower case. Limit values are assumed to be in 
dBc/ Hz, so it is not necessary to specify a unit. 
You must enter at least two samples in ascending order of frequency with the lowest frequency 
at the top of the table. The total number of samples entered is shown by the Samples field. If 
you enter an illegal or out-of-range value, a message will be displayed in the Status Bar (p54) 
showing the range of acceptable values 
 
See Using Table Entry Boxes (p61) for more information. 

Activate/Deactivate 
Changes the status of the limit line to active or not active. When active the limit line will appear 
on the Graph panel. 
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Shift Level 
Opens the Shift Level (p40) dialogue box. 

Insert 
Inserts a new row in the Values box at the highlighted position. 

Delete 
Removes the highlighted row in the Values box. 

Samples 
Displays the number of samples that have been defined. 

Maximum 
Displays the maximum number of samples that can be defined. This value is always 50. 
 
 

Shift Level 

Use this dialogue to alter the level of all samples in the limit line by an amount that you specify. 
 
 
Dialogue Box Options 

Level Offset 
Type the offset value you want to use. 
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View Menu 
The View menu comprises the commands used for customizing the screen by displaying or hiding 
various information panels, traces and measurement results. 
 
 
Graph command (View Menu) 
This command only appears when a check mark appears next to the Measurement Log (p47) command 
in the Options menu. 
Use this command to display or hide the Graph and Markers panels. 
A check mark appears next to the command name when the Graph is displayed. 
For more information, see Graph (p55). 
 
 
Log command (View Menu) 
This command only appears when a check mark appears next to the Measurement Log (p47) command 
in the Options menu. 
Use this command to display or hide the Log panel, which lists information about the progress of each 
measurement as well as reporting key values used or measured.  
A check mark appears next to the command name when the Log is displayed. 
For more information, see Log (p56). 
 
 
Uncorrected command (View Menu) 
This command is only enabled when the reference trace buffer is not empty. A measurement trace may 
be copied into the reference buffer using the Trace to Reference (p44) command in the Sweep menu. 
Use this command to display the Uncorrected trace on the Graph panel. A check mark appears next to 
the command name when the Uncorrected trace is displayed. This command also hides the Corrected 
trace. 
When this command is checked the Uncorrected trace will also appear in the Report Diagram. 
 
 
Reference command (View Menu) 
This command is only enabled when the reference trace buffer is not empty. A measurement trace may 
be copied into the reference buffer using the Trace to Reference (p44) command in the Sweep menu. 
Use this command to display or hide the Reference trace on the Graph panel. A check mark appears 
next to the command name when the Reference trace is displayed.  
When this command is checked the reference trace will also appear in the Report Diagram. 
 
 
Corrected command (View Menu) 
This command is only enabled when the reference trace buffer is not empty. A measurement trace may 
be copied into the reference buffer using the Trace to Reference (p44) command in the Sweep menu. 
Use this command to display the Corrected trace on the Graph panel. A check mark appears next to the 
command name when the Corrected trace is displayed. This command also hides the Uncorrected 
trace. 
When this command is checked the Corrected trace will also appear in the Report Diagram. 
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Residual PM command (View Menu) 
Use this command to display or hide the calculated Residual Phase Modulation on the Graph panel. A 
check mark appears next to the command name when the Residual PM is displayed. 
In Normal Marker mode, or with no markers displayed, Residual Phase Modulation is calculated using 
all measured values from the Minimum Offset to the Maximum Offset inclusive. In Delta Marker mode, 
the calculation is based on the measured samples that lie between the two markers, and is updated 
each time the frequency of either marker changes. 
When this command is checked the Residual PM value will also appear in the Report Diagram. 
 
 
Residual FM command (View Menu) 
Use this command to display or hide the calculated Residual Frequency Modulation on the Graph panel. 
A check mark appears next to the command name when the Residual FM is displayed. 
In Normal Marker mode, or with no markers displayed, Residual Frequency Modulation is calculated 
using all measured values from the Minimum Offset to the Maximum Offset inclusive. In Delta Marker 
mode, the calculation is based on the measured samples that lie between the two markers, and is 
updated each time the frequency of either marker changes. 
When this command is checked the Residual FM value will also appear in the Report Diagram. 
 
RMS Jitter command (View Menu) 
Use this command to display or hide the calculated RMS Jitter on the Graph panel.  A check mark 
appears next to the command name when the RMS Jitter is displayed. 
In Normal Marker mode, or with no markers displayed, RMS Jitter is calculated using all measured 
values from the Minimum Offset to the Maximum Offset inclusive.  In Delta Marker mode, the calculation 
is based on the measured samples that lie between the two markers, and is updated each time the 
frequency of either marker changes. 
When this command is checked the RMS Jitter value will also appear in the Report Diagram. 
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Sweep Menu 
The Sweep menu comprises the commands used for starting and terminating a measurement and for 
storing and deleting the reference trace. 
 
 
Start command (Sweep Menu) 
Use this command to begin a new Sweep measurement using the current Analyzer Setup file. 

Note: Any displayed Sweep results will be cleared by this command. 

FS-K4 starts by configuring the analyzer according to the current Analyzer Setup. If for any reason the 
Analyzer does not respond, an error message will be displayed describing the problem. See 
Communication Problems (p65) for more information. 
If the Verify Frequency and Level function is selected in the Sweep Setup (p35) dialogue box, FS-K4 will 
then check to see if there is a Signal within the specified Frequency and Level Tolerance ranges relative 
to the specified Signal Frequency and Level. If no Signal is found, or a Signal is found, which is outside 
the tolerance range, an information dialogue will be displayed describing the problem, and the 
measurement will be aborted. 
As soon as the Sweep starts, "Sweep running... (0%)" will appear in the Status Bar. The percentage 
indicator will increase each time a new block of data is displayed and is calculated as the ratio of values 
received to total values expected. 
The overall sweep is divided into a number of sub-bands, which are measured separately. This is 
optimized to provide the best combination of measurement accuracy and speed. If the RF Overload 
warning is activated whilst measuring a sub-band, the input attenuation will be increased by 10dB and 
the sub-band will be re-measured. If the sweep cannot be completed for any reason, an information 
dialogue will be displayed describing the problem and the measurement will be aborted. 
Once the Sweep is finish, "Sweep complete" appears in the Status Bar. 
 
 
Stop command (Sweep Menu) 
Use this command to terminate a Sweep measurement. 
"Sweep aborted" will appear in the Status bar (p54), an information dialogue will be displayed confirming 
the action, and FS-K4 will stop the Sweep. 
 
 
Mode command (Sweep Menu) 
Use this command to switch repetitive Sweeping on and off and also to choose between Graph (p55) 
display modes Clear/Write and Max. Hold. 
A sub-menu appears when this command is selected with the following options: 
 
Clear/Write 

Use this command to disable repetitive Sweeping and select Clear/Write display mode. 
The Sweep will then end at the stop frequency of the Sweep. 
A check mark appears next to the command name when this mode is selected. 
 

Repeat Clear/Write 
Use this command to enable repetitive Sweeping in the Clear/Write display mode. 
The Sweep will then automatically re-start each time the Analyzer reaches the stop frequency of 
the Sweep. In Clear/Write mode, the Graph panel displays only those values measured during 
the current pass. 
A check mark appears next to the command name when this mode is selected. 
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Repeat Max. Hold 
Use this command to enable repetitive Sweeping in the Max. Hold display mode. 

The Sweep will then automatically re-start each time the Analyzer reaches the stop frequency of 
the Sweep. In Max. Hold mode, the Graph displays the maximum value measured at each 
frequency during all passes since the Repeat Max. Hold command was used. 
A check mark appears next to the command name when this mode is selected. 
 
 

Trace to Reference command (Sweep Menu) 
Use this command to copy the main Sweep trace into the Reference Trace Buffer. 
You can then make a new measurement or load an existing Result Data file and compare the traces in 
the following ways: 

• use the Reference (p41) command in the View menu to display the reference with the main 
trace then, 

• use the Graph (p55) panel to compare them visually or  
• use the Markers (p56) to compare them point by point or 
• use the Corrected (p41) command in the View menu to display the calculated difference 

between the main and reference traces. 
 

Note:  Both traces must be measured using the same Analyzer setup. The reference trace will be 
cleared as soon as an incompatible setup is loaded. 

 
Reference trace data may be stored along with other measurement results by using the Save (p32) 
command with the File of Type box set to Result Data. 
 
 
Clear Reference command (Sweep Menu) 
Use this command to clear the contents of the Reference Trace Buffer. 
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Marker Menu 
The Marker menu comprises the commands used for handling the marker functions and for magnifying 
a selected portion of the measured spectrum. 
 
 
Normal command (Marker Menu) 
Use this command to display or hide the Normal marker and the Markers box, which shows the current 
frequency and level co-ordinates of the Graph marker(s). 
A check mark appears next to the command name when the Normal marker and Marker box are 
displayed. 
For more information, see Markers (p56) and Moving the marker (p60). 
 
 
Delta command (Marker Menu) 
Use this command to switch between normal and delta marker modes. 
In delta mode, the Delta marker will initially appear superimposed on the Normal marker. All keyboard 
and mouse methods for marker positioning will apply to the Delta marker, whilst the Normal marker will 
remain fixed in position, see Moving the marker (p60) for details. 
A check mark appears next to the command when the delta marker mode is selected. 
For more information, see Markers (p56). 
 
 
Next Marker command (Marker Menu) 
This command is only enabled when the delta marker is active. 
Use this command to toggle control of marker frequency between the Normal and Delta markers. 
 
 
Measure at Marker command (Marker Menu) )  
Use this command to measure phase noise using the analyzer’s Phase Noise Marker at the current 
marker frequency. 
If the marker frequency is not between the analyzer’s current start and stop frequencies, the sub-band 
containing it will be swept first using the current Analyzer Setup parameters. 
This command provides a convenient method for checking Phase Noise at spot frequencies. 

Note: This command is disabled whilst a Sweep measurement is running. 
 
 
Zoom In command (Marker Menu) )  
Use this command to magnify a selected portion of the measured spectrum displayed by the Graph 
(p55). 
This may be used when more values have been measured than can be represented on the horizontal 
axis due to insufficient display resolution. The frequency axis of the Graph is expanded and all traces 
and the limit lines are redrawn. The level axis is not affected. 
You can use the Zoom In command repeatedly until all detail is visible at which point the command is 
disabled. 
The frequency range covered by the zoom function depends on the marker mode: 

Normal (p45)  The frequency axis is expanded to show 10% of the display width 
centered on the current marker frequency. In the vicinity of the start 
and stop frequencies the software performs an adaptation. 

 
Delta (p45)  The frequency axis is expanded to show the band between the 

normal and delta markers 
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Zoom Out command (Marker Menu)  
Use this command to undo the last Zoom In (p45) command. 

The new display will be centered on the Normal Marker frequency. In the vicinity of the start and stop 
frequencies the software performs an adaptation. 
You can use the Zoom Out command repeatedly until all Zoom commands have been undone and the 
complete measurement spectrum is displayed. If you want to undo the all Zoom commands in one go, 
choose the Original Diagram (p46) command. 

Note: This command is only available when the Delta (p45) marker is disabled. 
 
 
Original Diagram command (Marker Menu) 
Use this command to undo all Zoom commands and display the complete measurement spectrum. 
This command is automatically performed whenever the Start (p43) command is used to make a new 
Sweep measurement. 
If you want to undo the last Zoom In command, choose the Zoom Out (p46) command. 
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Options Menu 
The Options menu offers various settings specifying the Measurement Log function, the components of 
the display, the default paths for data files and the analyzer. All settings made in this menu can be saved 
to disk.. 
 
 
Measurement Log command (Options Menu) 
Use this command to enable or disable the Measurement Log function. 
A check mark appears next to the command name when the Log is enabled. 
For more information, see Log (p56). 
 
 
Display command (Options Menu) 
Use this command to modify the color, style and width of various components that form the Sweep 
Graph display. 
 
Dialogue Box Options 

Feature 
Select the component you want to change. 

Note: Text style and width default to solid and 1 respectively, and cannot be modified. 

Color 
Select a new color for the component you select in the Feature box. 

Style 
Select a new style for the component you select in the Feature box. 

Note: For line widths greater than 1, the style defaults to solid and cannot be modified. 

Width 
Select a new width for the component you select in the Feature box. 

Sample 
This box displays a line drawn using the current color, style and width settings. 

Default 
Select this button to return all color, style and width settings to the following default values: 
 

Feature Color Style Width 

Border Black Solid 1 

Vertical Grid Major Grey Solid 1 

Vertical Grid Minor Grey Dot 1 

Horizontal Grid Grey Dot 1 

Text Black Solid 1 

Trace Blue Solid 1 

Ref. Trace Cyan Solid 1 

Limit Light Red Dash 1 

Normal Marker Light Red Solid 1 

Delta Marker Light Magenta Solid 1 
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Default Paths command (Options Menu) 
Use this command to modify the default locations of each type of data file used by FS-K4. 
 
Dialogue Box Options 

Default directory 
This field displays the current default directory for the data type you select in the Files of Type 
box. 

Files of Type 
Select the type of file whose default directory you want to modify. 
Analyzer Setup Analyzer Setup files. 
Result Data Result Data files. 
Limit Line Limit Line files. 

Directories 
Select the default directory in which FS-K4 will store the data type you select in the Files of Type 
box. The default directory will not actually change until the Set command button is selected. 

Note:  To select a directory, double click on the directory name until the open folder icon is 
shown.  

Drives 
Select the default drive on which FS-K4 will store the data type you select in the Files of Type 
box. The default directory will not actually change until the Set command button is selected. 

Set 
Select this button to copy the current drive and directory settings to the Default directory field. 
 
 

Analyzer command (Options Menu) 
Use this command to modify the default Analyzer type, address and start-up conditions. 

Note:  At startup, FS-K4 will check to see if the analyzer it was last used with is present. If not, it 
checks to see if it is running on the analyzer itself. It this fails, it checks each GPIB address.  

• If no analyzer is found, FS-K4 assumes that you will connect an analyzer later, and selects the 
analyzer type used most recently as the default.  

• If FS-K4 is running on the analyzer, it selects the internal, DDE communications method, which 
bypasses the GPIB, and sets this analyzer and communications method as the new default.  

• Finally, if an analyzer is found at a GPIB address, it is selected as the new default.  
 

This command allows you to override these settings when an analyzer is connected to the bus after 
startup. 
 
Dialogue Box Options 

Use DDE 
When FS-K4 is run on the analyzer, this enables control of the analyzer without using the GPIB. 

Use GPIB 
When FS-K4 is not run on the analyzer, this enables control of the analyzer using the GPIB. 

Address 
Select the bus address of the Analyzer you want to work with. If the analyzer is connected and 
turned on when you start FS-K4, this value will be set automatically. 
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Initialize on start-up 
Enables initialization of the Analyzer each time FS-K4 is started. This is equivalent to pressing 
the PRESET key on the front panel of the Analyzer. 
 
 

Save Options command (Options Menu) 
Use this command to save all Options Menu settings to disk. 
Each setting is written to the FS-K4.INI file, which resides in your Windows directory. Each time you 
restart FS-K4, these settings will be used. 

Note: To make temporary changes, simply use the Options Menu commands to alter the settings 
as required, but do not use the Save Options command. Next time you start FS-K4 the 
temporary settings will be replaced with your normal settings. 
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Help Menu 
The Help Menu offers commands used for starting the FS-K4 on-line Help and obtaining information on 
the installed software and on product support services. 
 
 
 
Contents command (Help Menu) 
Use this command to display the opening screen of Help. From the opening screen, you can jump to 
various types of reference information. 
Once you open Help, you can click the first button on the left in the help window whenever you want to 
return to the opening screen. 
 
 
 
Search for Help on command (Help Menu) 
Displays Help's Search dialogue so you can quickly find the information you need. 
 
 
 
Obtaining Technical Support command 
Gives details on product support services for FS-K4 available to you from Rohde & Schwarz. 
 
 
 
About FS-K4 command (Help Menu) 
Use this command to display the version number of your copy of FS-K4 for Windows, the copyright 
notice, Windows mode, available memory, and installed math co-processors. 
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Control Menu 

 
 
The Control menu is located at the left end of the title bar in an application window. It comprises the 
commands used for modifying or closing the active application window and for switching to another 
application. 

To display commands that control the size and position of an application window, click the application 
Control-menu box or press ALT+SPACEBAR. 
 
 
Restore command  (Control menu) 
Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command. 

Clicking  in the upper-right corner of a maximized window is the same as choosing the Restore 
command. 
 
Shortcuts 

Mouse: Double-click the title bar. 
 
 

Move command (Control menu) 
Use this command to display a four-headed arrow so you can move the active window or dialogue box 
with the arrow keys. 

 
Note: This command is unavailable if you maximize the window. 
 
 
Size command  (Control menu) 
Use this command to display a four-headed arrow so you can move the active window or dialogue box 
with the arrow keys. 

 
Note: This command is unavailable if you maximize the window. 
 
 
Minimize command  (Control menu) 
Use this command to reduce the FS-K4 window to an icon. 

Clicking  in the upper-right corner of the window is the same as choosing the Minimize command. 
 
 
Maximize command (Control menu) 
Use this command to enlarge the FS-K4 window to fill the entire screen. 

Clicking  in the upper-right corner of the window is the same as choosing the Maximize command. 
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Shortcuts 
Mouse: Double-click the title bar 
 
 
 

Close command (Control menu) 
Use this command to close the FS-K4 window. 
Double-clicking a Control-menu box is the same as choosing the Close command. 
 

 
 
Shortcuts 

Keys: ALT+F4 closes the FS-K4 window 
 
 
 

Switch To command (Control menu) 
Use this command to display a list of all open applications. Use this "Task List" to switch to or close an 
application on the list. 
 
Shortcut 

Keys: CTRL+ESC 
 

Dialogue Box Options 

Task List 
Select the application you want to switch to or close. 

Switch To 
Makes the selected application active. 

End Task 
Closes the selected application. 

Cancel 
Closes the Task List box. 

Cascade 
Arranges open applications so they overlap and you can see each title bar.  

Note: This option does not affect applications reduced to icons. 

Tile 
Arranges open applications into windows that do not overlap.  

Note: This option does not affect applications reduced to icons. 

Arrange Icons 
Arranges the icons of all minimized applications across the bottom of the screen. 
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4 Parts of the FS-K4 Screen 

The Application Window for FS-K4 is divided into the workspace where all measured data is displayed 
and manipulated, and various control elements and information areas. 
 
 
 

FS-K4 Control menu 

 
Located at the left end of the title bar in an application window. 
To display commands that control the size and position of an application window, click the application 
Control-menu box or press ALT+SPACEBAR. 

For more information, see section „Control Menu“ on page 51. 
 
 

Maximize button 

 
Located at the right end of the title bar when the application is not maximized. 
When you click the maximize button, the application window enlarges to fill the screen. 

Note: Maximized windows have no borders. 
 
 

Menu bar 

 
Located below the title bar, along the top of the application window, this area contains a list of FS-K4 
commands. 
To view all the commands in a menu, do one of the following: 
Click the menu name. 
Press ALT+n, where n is the underlined letter in the menu name. For example, press ALT+F to open the 
File menu. 
 
 

Minimize button 

 
Located at the right end of the title bar when the application is not minimized. 
Clicking the Minimize button is the same as choosing Minimize from the application Control menu: The 
application window shrinks to an icon. 
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Restore button 

 
Located at the right end of the title bar when the application window is minimized or maximized. 
Clicking the Restore button is the same as choosing Restore from the application Control menu: The 
application window returns to its previous size. 
 
 

Status Bar 

 
This is the area across the bottom of the application window below the workspace.  
It contains four fields: 
 
Message Field  

During long operations this field displays a short message describing the current activity. In 
certain cases this includes a counter showing the percentage of the task completed so far. 
 

Trace Indicator 
Shows the descriptions of the active traces. 
 

Caps Lock Indicator  
Shows the current status of the Caps Lock key on the keyboard. When the key is active CAPS 
appears, otherwise the field is empty. 
 

Num Lock Indicator  
Shows the current status of the Num Lock key on the keyboard. When the key is active NUM 
appears, otherwise the field is empty. 
 
 

Title Bar 

 
This is the area across the top of the application window between the system menu icon and the 
minimize, maximize and restore buttons. It displays the application name "FS-K4" and the name of the 
current file. FS-K4 deals with several different file types of varying degrees of importance. The title bar 
always displays the name of the most important data type currently in use. If the file has been altered in 
any way since it was loaded this will be indicated by the word (modified) appearing to the right of the file 
name. 
 
The data types are as follows: 

Data Type File Extension Importance 

Limit Line *.lim Least 

Analyzer Setup *.set  

Result Data *.dat Most 

 
At start-up the default setup for the current default Analyzer is automatically loaded. This has the name 
"New Setup". 



FS-K4 Parts of the FS-K4 Screen 

1108.0107.42 55 E-6 

Workspace 

 
 
This is the area below the menu bar in which all measured data is displayed and manipulated. It 
contains three areas as follows: 
1. Graph (p55) area showing the sweep trace as a 2-dimensional graph, 
2. Log (p56) area displaying information on the last measurement, 
3. Markers (p56) area showing the current co-ordinates of the active markers. 
 
 
Graph 

 
 
Displayed in the top left of the workspace area, below the menu bar. 
Shows sweep trace data in graphical form with, optional limit line, and calculated values of Residual PM, 
Residual FM, and RMS Jitter. The minimum and maximum values of each axis reflect the frequency 
offset and level ranges defined in the current Analyzer Setup. 

A Markers area (p56) may also be displayed, which allows the precise frequency offset and phase noise 
of each data point to be read from the screen. 
To hide or display the Graph, choose Graph from the View menu (ALT, V, G). 

Hint:  The Graph region scales with the application window and always fills the available space 
within the workspace area. In order to see the most detail, maximize the application and 
then use the View and Marker menu commands to hide the Log and Normal Marker. 
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Log 

 
 
Displayed at the bottom of the workspace area, above the status bar. 
Displays detailed progress and result information for the most recent sweep measurement and any 
subsequent Measure at Marker operations. 
The logging function is only enabled when a tick appears next to the Measurement Log command in the 
Options menu (ALT, O, L). 
When logging is enabled use the Log command in the View menu (ALT, V, L) to hide or display the Log 
region. 
Log information for a sweep measurement is automatically saved and loaded with the Result Data 
(*.DAT) file. It is stored in a text file (*.TXT) with the same filename as the Result Data file, i.e. if you 
save Result Data to “MYDATA.DAT” the log information will be saved to “MYDATA.TXT”. 
See Log Text Files (p72) for a description of the Log file content. 
 
 
Markers 

 
 
Displayed in the top right of the workspace area, below the menu bar. 
Shows the current co-ordinates of the Graph marker(s) and the analyzer’s Phase Noise Marker. 
To hide or display the Marker region, choose Normal from the Marker menu (ALT, M, N). 
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Note: If the Graph is hidden using the Graph command in the View menu, the Marker region is 
hidden also. 

 
Normal  

This group of fields are always displayed when the Normal marker is enabled. 

Frequency 
Shows the frequency offset relative to the carrier at the current position. 

Level 
Shows the absolute phase noise level at the current position 

Ref. Offset 
This field only appears when the Reference (p41) trace is displayed. It shows the difference 
between the main and reference traces at the current position. 
 

Delta  
This group of fields are only displayed when the Delta marker is enabled. 

Frequency 
Shows the frequency offset relative to the Normal marker at the current position. 

Level 
Shows the phase noise level offset relative to the Normal marker at the current position 

Ref. Offset 
This field only appears when the Reference (p41) trace is displayed. It shows the difference 
between the main and reference traces at the current position. 
 

Phase Noise Marker 
This group of fields only appears when the Measure at Marker command is used. 

Frequency 
Shows the frequency offset relative to the carrier at the current Phase Noise Marker position 

Level 
Shows the absolute phase noise level reported by the Phase Noise Marker at the current Phase 
Noise Marker position. 
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5 Keyboard and Mouse 

The following chapter gives an overview of the keyboard and mouse functions which can be used for 
entering characters and numbers, editing text, handling markers and for various other tasks. 
 
 

Deleting and inserting text 
FS-K4 has numerous shortcut keys you can use to delete or insert text. 
 
Deleting text 
To Press 

Delete one character to the left of the insertion point or selected text BACKSPACE 

Delete one character to the right of the insertion point or selected text DEL 

Delete selected text and send it to the Clipboard CTRL + X or SHIFT + DEL 

Reverse the last action (also known as "undo") CTRL + Z 

 
Inserting text 
To Press 

Copy text to the Clipboard CTRL + C or CTRL + INS 

Insert Clipboard contents CTRL + V or SHIFT + INS 

 
 

Function keys 
You can use the function keys on your keyboard to perform many tasks faster. 

F1 
To Press 

Get help on the selected command, open dialogue box, or a message F1 

 
F3 
To choose Press 

Sweep Setup (p35) from the Edit Menu F3 

 
F5 
To choose Press 

Start (p43) from the Sweep Menu F5 

 
F8 
To choose Press 

Stop (p43) from the Sweep Menu F8 
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F10 
To choose Press 

Make the menu bar active F10 

 
F11 
To choose Press 

New (p31) from the File Menu F11 

 
F12 
To choose Press 

Save As (p32) from the File Menu F12 

Open (p31) from the File Menu CTRL + F12 

Save (p32) from the File Menu SHIFT + F12 

Print (p34) from the File Menu CTRL + SHIFT + F12 

 
 
 

Moving the insertion point in a text entry field 
To move the insertion point through a text field: 

  Click the new location. 

  Do one of the following. 
 

To move Press 

One character to the left  

One character to the right  

One word to the left CTRL +  

One word to the right CTRL +  

To the end of a line END 

To the beginning of a line HOME 

 
 
 

Moving the marker 

  Position the mouse pointer over the Graph (p55) at the desired frequency and click the 
left mouse pointer. The marker will move to the selected frequency. 

 

 1. Press ALT + G to move focus to the Graph. 
 2. Use the  and  keys for coarse positioning of the marker. 
 3. Use the  and  keys to move the marker to the desired frequency. 
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Re-measuring at the Marker 

  Do one of the following. 
 1. Position the mouse pointer over the Graph (p55) at the desired frequency. 
 2. Double-click the left mouse button. If the selected frequency is outside the current 

analyzer settings, the sub-band containing the frequency will be re-measured. The 
Analyzer will then position its Phase Noise Marker at the selected frequency and the 
measured phase noise will be reported in the Markers panel.  

 Alternatively 
 1. Position the mouse pointer over the Graph at the desired frequency and click the left 

mouse button. The marker will move to the selected frequency. 
 2. Choose the Measure at Marker (p45) command from the Marker menu. 

 1. Press ALT + G to move focus to the Graph. 
 2. Use the  and  keys to move the marker to the desired frequency. See 

Moving the marker (p60) for more information. 
 3. Choose the Measure at Marker (p45) command (ALT, M, M) from the Marker menu. 
 
 

Selecting in a text entry field 

  Do one of the following: 
 

To select Do this 

Any text Drag across the text you want to select.  
You can also select any text by placing the insertion point at one end of the 
text you want to select, then holding down the SHIFT key, and then clicking 
the opposite end of the text. 

A word Double-click the word. 

  Do one of the following: 
 

To extend selection Press 

One character to the left SHIFT +  

One character to the right SHIFT +  

One word to the left CTRL + SHIFT +  

One word to the right CTRL + SHIFT +  

To the end of a line SHIFT + END 

To the beginning of a line SHIFT + HOME 

 
 

Using Table Entry Boxes 
Description 
 
A Table Entry box consists of: 

The Settings box   
Located at the top of the Table Entry box, this is where you make a change to the selected 
entry. Simply enter the new value by typing it in the Settings box. Click the Enter button 
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{bmc ticksel.bmp} to accept the change, or click the Cancel button {bmc crosssel.bmp} to 
cancel the change. 

 

The Data list  
Located at the bottom of the Table Entry box, this list shows the data that you enter into the 
table and allows you to select an entry to modify. 
 

Table Entry Box Keys 
Use these key combinations when the Data list has the focus: 

Press To 

Shift+Tab Switch focus to the command buttons. 

Page Down Move down through the Data list. 

Page Up Move up through the Data list. 

 Move down through each entry. 

 Move up through each entry. 

 Move right and down through each entry. 

 Move left and up through each entry. 

End Move to the right hand column. 

Home Move to the left hand column. 

Alpha Move the insertion point to the Settings box and enter a new value. 

Tab Move the insertion point to the Settings box. 

For on/off entries simply double click over the entry to switch between the two values. 
Use these key combinations when the Settings box has the focus: 

Press To 

Ctrl+Z Undo the last editing action in the current line. 

Ctrl+C Copy the selected text to the Clipboard. 

Ctrl+X Cut the selected text to the Clipboard. 

Del Delete the selected text without placing it on the Clipboard. 

Ctrl+V Paste the Clipboard contents at the insertion point. 

Enter Move the insertion point into the Data list and commit the entry change. 

Shift+Tab Switch focus to the Data list without committing the entry change. 

Tab Move the focus to the Data list and commit the entry change. 

Esc Move the focus to the Data list and cancel the entry change. 
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6 Command Line Options 

You can use the following switches to change the way FS-K4 behaves when you start the application. 
 
Switch Argument Description 

/FR [drive][path]filename Load the specified result data file (*.dat). If you do not specify a 
drive or path, FS-K4 will look in the default Result Data directory 
specified in the Options Default Paths dialogue box. 
For example /FRD:\RESULTS\MYDATA.DAT 

/FS [drive][path]filename Load the specified Analyzer setup file (*.set) 
For example /FSD:\STANDARD\EN55022.SET 

/LI none Enables listing of all GPIB operations to a file in the FS-K4 
directory called GPIB.DOC. This is intended for problem solving 
and should not be used on a regular basis since it reduces 
system performance.  

/SL none Forces FS-K4 to use monochrome bit maps for the tick and 
cross buttons in Table Entry boxes. This can make these buttons 
more readable on some display adapters. 

 
 
The following switches temporarily override the corresponding settings in the Options Analyzer dialogue 
box. 
 
Switch Argument Description 

/R FSEA 20(+B2)(+B4)(+B5) | 
FSEA 30(+B2) | 
FSEB 20(+B4)(+B5) | 
FSEB 30 | 
FSEM 20(+B4)(+B5) | FSEM 30 | 
FSEK 20(+B4)(+B5) | FSEK 30 | 
FSIQ 3(+B2) | FSIQ 7 | FSIQ 26 | 
FSIQ 40 | ESIB 7 | ESIB 26 | 
ESIB 40 | FSP 3 | FSP 7 | FSP 13 | 
FSP 30 | FSP 40 | ESPI 3 | ESPI 7 | 
FSU 3 | FSU 8 | FSU 26 | FSU 46 | 
FSU 50 | FSQ 3 | FSQ 8 | FSQ 26 

Specify a different default Analyzer type. 

For example /RFSEM 30 

Note: the text in parentheses is optional and should only be 
included if the Analyzer is fitted with the corresponding option. 

/ID none Disable Initialize on Start-up function 
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7 Communication Problems 

If the application fails to communicate with the Analyzer, a message box is displayed describing the 
problem. The following possibilities exist: 
 

Problem Suggested Action 

The computer is not fitted with an GPIB 
card. 

Choose the Cancel button to ignore the problem. The application 
continues normally but you can only use commands that do not involve 
the Analyzer. 

The interface card is not configured 
correctly. 

Use the configuration software supplied with the interface card to set all 
parameters to their default condition and then choose Retry. 
Alternatively choose Cancel to ignore the problem and then re-configure 
the card at a later time and before attempting to use any Analyzer 
functions. FS-K4 is designed to work with the default settings as 
supplied with the card. 

The Analyzer is not connected to the 
interface card. 

Connect the Analyzer and choose Retry. Alternatively choose Cancel to 
ignore the problem and then connect the Analyzer before attempting to 
use any Analyzer functions. 

The Analyzer is not switched on. Turn the Analyzer on, wait for it to initialize, and then choose Retry. 
Alternatively choose Cancel to ignore the problem and then turn on the 
Analyzer before attempting to use any Analyzer functions.  

The Analyzer bus address does not match 
that specified in the Options Analyzer 
dialogue box. 

Change the Analyzer address to match that set in the Options Analyzer 
dialogue box and then choose Retry. Alternatively choose Cancel to 
ignore the problem and then modify the address in the Options 
Analyzer dialogue box before attempting to use any Analyzer functions. 
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8 Data Storage Format 

With the exception of Log Text Files, FS-K4 stores all setup and result data in the form of ASCII tab 
delimited files. 
The first line of each file is the long description that you enter in the right hand side of the File 
Description box in the Save As dialogue box. The remainder consists of EntryValue pairs representing 
run-time options for the application. Related entries are grouped together in Sections, which start with a 
section name in square brackets [], and finish with [END]. 
 
There are five different types of data file as follows: 
 
Limit Line Files (p67)  Contains a Limit Line definition 
Analyzer Setup Files (p68)  Contains definitions for a Sweep Setup and an optional Limit Line  
Result Data Files (p70)  Complete list of measured values, definitions for the Sweep Setup used 

to make the measurement, and an optional Limit Line. 
Log Text Files (p72)  Complete text of the measurement log generated during a 

measurement. 
FS-K4.INI (p74)  Configuration settings 
 
 
 

Conventions Used in Descriptions of Data Storage Format  
This section uses the following typographic conventions 

keywords In syntax, normal letters indicate information you must type as shown. 
description In syntax, letters with serifs indicate descriptive information, which you should 

NOT include. 
variable In syntax, italic letters can indicate placeholders for information you supply. 
{ON | OFF} In syntax, braces and a vertical bar indicate a choice between two or more 

items. You must choose one of the items unless all of the items also are 
enclosed in angle brackets. 

(option) In syntax, parentheses indicate optional items. For example ‘FSEA 
20(+B2)(+B4)(+B5)’ means the text string ‘FSEA 20’ plus any combination of the 
text strings ‘+B2’, ‘+B4’, and ‘+B5’ including none of them. 

TAB The tab character, ASCII 9. 
 
 
 

Limit Line Files 
These contain the following groups and entries 
 
Line [Group] or Entry Value 

1  Long description, which you enter in the right hand side of File Description box in the 
Save As dialogue box 

2 [VERSION]  

3 VERSION Software version used to write the file, enclosed in single quotes 

4 [END]  

5 [LIMIT]  
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Line [Group] or Entry Value 

6 MAX Value of limit parameter in peak vertex 

7 NAME Identifier entered in Name box of Limit Line dialogue box, enclosed in single quotes 

8 BANK 0 

9 LENGTH Number of vertices 

10 VERTEX 0 TAB Frequency of first vertex TAB Limit value of first vertex 

11 VERTEX 1 TAB Frequency of second vertex TAB Limit value of second vertex 

 M    M    M 

10+(n-1) VERTEX n-1 TAB Frequency of last vertex TAB Limit value of last vertex. Where n = the number 
of vertices. 

10+n [END]  

 
 
 

Analyzer Setup Files 
These contain the following groups and entries 
 
Line [Group] or Entry Value 

1  Long description, which you enter in the right hand side of File Description 
box in the Save As dialogue box 

2 [VERSION]  

3 VERSION Software version used to write the file, enclosed in single quotes 

4 [END]  

5 [RX SETUP]  

6 RX TYPE { 'FSEA 20(+B2)(+B4)(+B5)' | 'FSEA 30(+B2)’ | 'FSEB 20(+B4)(+B5)' | 
'FSEB 30' | 'FSEM 20(+B4)(+B5)' | 'FSEM 30' | 'FSEK 20(+B4)(+B5)' | 
'FSEK 30' | 'FSIQ 3(+B2)' | 'FSIQ 7' | 'FSIQ 26' | 'FSIQ 40' | 'ESIB 7' |  
'ESIB 26' | 'ESIB 40' | 'FSP 3' | 'FSP 7' | 'FSP 13' | 'FSP 30' | 'FSP 40' | 
'ESPI 3' | 'ESPI 7' | 'FSU 3' | 'FSU 8' | 'FSU 26' | ‘FSU 46’ | ‘FSU 50’ |  
'FSQ 3' | 'FSQ 8' | 'FSQ 26' } 

7 GRID START FREQ Graph x-axis start frequency in hertz 

8 GRID STOP FREQ Graph x-axis stop frequency in hertz 

9 GRID MINLEVEL Graph y-axis minimum in dBc/ Hz 

10 GRID MAXLEVEL Graph y-axis maximum in dBc/ Hz 

11 SWEEP CENTER FREQ Signal frequency in hertz 

12 SWEEP FREQ TOLERANCE Signal tolerance frequency in hertz 

13 SWEEP LEVEL TOLERANCE Signal tolerance level in dB 

14 SWEEP MIN FREQ OFFSET Minimum offset frequency to be measured in hertz 

15 SWEEP MAX FREQ OFFSET Maximum offset frequency to be measured in hertz 

16 SWEEP DISPLAY REF 0 

17 SWEEP REF LEVEL Graph y-axis maximum in dBc/ Hz 

18 SWEEP LEVEL RANGE Graph y-axis range in dB 

19 SWEEP LEVEL OFFSET Offset value to be added to all measured values in dB 

20 SWEEP COUPLING RATIO { 10 | 1 | 0.1 } where 10 means 'RBW = 10 x VBW', 1 means 'RBW = VBW', 
and 0.1 means '10 x RBW = VBW' 
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Line [Group] or Entry Value 

21 SWEEP SMOOTHING WINDOW Smoothing window width in number-of-samples 

22 SWEEP VERIFY CENTER { 1 | 0 } where 1 means "Verify Signal Frequency and Level", and 0 means 
"Do not Verify Signal Frequency and Level" 

23 REPORT HEADING User report text, enclosed in single quotes 

24 REPORT MEASUREMENT TYPE User report text, enclosed in single quotes 

25 REPORT EUT NAME User report text, enclosed in single quotes 

26 REPORT MANUFACTURER User report text, enclosed in single quotes 

27 REPORT CONDITIONS User report text, enclosed in single quotes 

28 REPORT OPERATOR User report text, enclosed in single quotes 

29 REPORT TEST SPEC User report text, enclosed in single quotes 

30 REPORT COMMENT 1 User report text, enclosed in single quotes 

31 REPORT COMMENT 2 User report text, enclosed in single quotes 

32 REPORT TITLES { 1 | 0 } where 1 means 'Include user report text', and 0 means 'Exclude user 
report text' 

33 REPORT DATE { 1 | 0 } where 1 means 'Include measurement complete date', and 0 means 
'Exclude measurement complete date' 

34 REPORT SWEEP { 1 | 0 } where 1 means 'Include setup information', and 0 means 'Exclude 
setup information' 

35 LIMIT UPPER NAME Identifier entered in Name box of Limit Line dialogue box, enclosed in single 
quotes 

36 LIMIT UPPER DESCRIPTION Long description, of limit line file, which you enter in the right hand side of 
File Description box in the Save As dialogue box, enclosed in single quotes 

37 LIMIT UPPER BANK 0 

38 SUBBAND RBW 1 1 RBW for decade 1, sub-band 1 

39 SUBBAND RBW 1 2 RBW for decade 1, sub-band 2 

40 SUBBAND RBW 1 3 RBW for decade 1, sub-band 3 

41 SUBBAND RBW 2 1 RBW for decade 2, sub-band 1 

42 SUBBAND RBW 2 2 RBW for decade 2, sub-band 2 

43 SUBBAND RBW 2 3 RBW for decade 2, sub-band 3 

44 SUBBAND RBW 3 1 RBW for decade 3, sub-band 1 

45 SUBBAND RBW 4 1 RBW for decade 4, sub-band 1 

46 SUBBAND RBW 4 2 RBW for decade 4, sub-band 2 

47 SUBBAND RBW 5 1 RBW for decade 5, sub-band 1 

48 SUBBAND RBW 6 1 RBW for decade 6, sub-band 1 

49 SUBBAND RBW 7 1 RBW for decade 7, sub-band 1 

50 SUBBAND RBW 8 1 RBW for decade 8, sub-band 1 

51 SUBBAND RBW 9 1 RBW for decade 9, sub-band 1 

52 SUBBAND SWEEPS 1 1 Sweep count for dec. 1, sub-band 1 

53 SUBBAND SWEEPS 1 2 Sweep count for dec. 1, sub-band 2 

54 SUBBAND SWEEPS 1 3 Sweep count for dec. 1, sub-band 3 

55 SUBBAND SWEEPS 2 1 Sweep count for dec. 2, sub-band 1 

56 SUBBAND SWEEPS 2 2 Sweep count for dec. 2, sub-band 2 

57 SUBBAND SWEEPS 2 3 Sweep count for dec. 2, sub-band 3 
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Line [Group] or Entry Value 

58 SUBBAND SWEEPS 3 1 Sweep count for dec. 3, sub-band 1 

59 SUBBAND SWEEPS 4 1 Sweep count for dec. 4, sub-band 1 

60 SUBBAND SWEEPS 4 2 Sweep count for dec. 4, sub-band 2 

61 SUBBAND SWEEPS 5 1 Sweep count for dec. 5, sub-band 1 

62 SUBBAND SWEEPS 6 1 Sweep count for dec. 6, sub-band 1 

63 SUBBAND SWEEPS 7 1 Sweep count for dec. 7, sub-band 1 

64 SUBBAND SWEEPS 8 1 Sweep count for dec. 8, sub-band 1 

65 SUBBAND SWEEPS 9 1 Sweep count for dec. 9, sub-band 1 

66 SUBBAND FFT 1 1 { 0 | 1 } where 0 means 'do not use FFT filter', and 1 means 
'do use FFT filter' for decade 1, sub-band 1 

67 SUBBAND FFT 1 2 { 0 | 1 } for decade 1, sub-band 2 

68 SUBBAND FFT 1 3 { 0 | 1 } for decade 1, sub-band 3 

69 SUBBAND FFT 2 1 { 0 | 1 } for decade 2, sub-band 1 

70 SUBBAND FFT 2 2 { 0 | 1 } for decade 2, sub-band 2 

71 SUBBAND FFT 2 3 { 0 | 1 } for decade 2, sub-band 3 

72 SUBBAND FFT 3 1 { 0 | 1 } for decade 3, sub-band 1 

73 SUBBAND FFT 4 1 { 0 | 1 } for decade 4, sub-band 1 

74 SUBBAND FFT 4 2 { 0 | 1 } for decade 4, sub-band 2 

75 SUBBAND FFT 5 1 { 0 | 1 } for decade 5, sub-band 1 

76 SUBBAND FFT 6 1 { 0 | 1 } for decade 6, sub-band 1 

77 SUBBAND FFT 7 1 { 0 | 1 } for decade 7, sub-band 1 

78 SUBBAND FFT 8 1 { 0 | 1 } for decade 8, sub-band 1 

79 SUBBAND FFT 9 1 { 0 | 1 } for decade 9, sub-band 1 

80 [END]    

81 [LIMIT]  
Same as [LIMIT] section in 
Limit Line Files (p67). 

   

86+
n 

[END]    

 
 
 

Result Data Files 
These contain the following groups and entries: 
 
Line [Group] or Entry Value 

1  Long description, which you enter in the right hand side of File Description 
box in the Save As dialogue box 

2 [VERSION]  

3 VERSION Software version used to write the file, enclosed in single quotes 

4 [END]  

5 [REPORT]  

6 VIEW MODE Bitmap value indicating display mode of Graph where bit 0 = Uncorrected 
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Line [Group] or Entry Value 

trace, bit 1 = Corrected trace, bit 2 = Reference trace, bit 3 = Residual PM, 
bit 4 = Residual FM, bit 7 = RMS Jitter. If the bit is set, the feature will be 
displayed. 

7 MARKER MODE Bitmap value indicating marker display mode where bit 0 = Delta Marker, bit 
1 = Normal Marker. If the bit is set, the Marker will be displayed  

8 MARKER NORMAL Frequency of Normal Marker in hertz.  

9 MARKER DELTA Frequency of Delta Marker in hertz. 

10 DATE STAMP Date and time at which measurement was completed, enclosed in single 
quotes  

11 SETUP NAME File name, of analyzer setup file, which you enter in the left hand side of File 
Description box in the Save As dialogue box, enclosed in single quotes 

12 SETUP DESCRIPTION Long description, of analyzer setup file, which you enter in the right hand 
side of File Description box in the Save As dialogue box, enclosed in single 
quotes 

13 [END]  

14 [RX SETUP]  
Same as [RX SETUP] 
section Analyzer Setup Files 
(p68). 

 

89 [END]  

90 [LIMIT]  
Same as [LIMIT] section in 
Limit Line Files (p67). 

 

95+n [END]  

96 [SWEEP DATA]  

97 START Minimum offset frequency measured in hertz 

98 STOP Maximum offset frequency measured in hertz 

99 TOTAL Number of measurement points expected. This is calculated as: 1 + 499 x 
the number of sub-bands measured 

100 MAX Number of measurement points that will be saved. If TOTAL > 30000 then 
this value is 30000, otherwise it is equal to TOTAL. 

101 NEXT Index that will be used for the next measurement point received - 1. If the 
measurement was completed this value will be equal to MAX. 

102 LAST Index that was used for the last measurement point received. If the 
measurement was completed this value will be equal to MAX. 

103 FACTOR Conversion factor from expected measurement point number to saved point 
index. If TOTAL is equal to MAX this will be -1, otherwise it will be: -1 x 
(MAX/TOTAL) 

104 LOGSCALE 0 

105 SIGNAL FREQUENCY Signal frequency measured by the Verify Signal Frequency and Level 
function in hertz. 

106 SIGNAL LEVEL Signal level measured by the Verify Signal Frequency and Level function in 
dBm. 

107 VERTEX 0 TAB Frequency of first vertex TAB Level value of first vertex TAB 0 TAB 1 

108 VERTEX 1 TAB Frequency of second vertex TAB Level value of second vertex TAB 0 
TAB 1 

M    M    M 

107+(n-1) VERTEX 1 TAB Frequency of last vertex TAB Level value of last vertex TAB 0 TAB 1. 
Where n = the number of saved points 

107+n [END]  
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Line [Group] or Entry Value 

107+(n+1) [SWEEP DATA]  
 

Same layout as preceding [SWEEP DATA] section. 

This section will only exist if the result data file includes a reference trace. 
When this section is included, the preceding [SWEEP DATA] section 
contains the reference trace data, and this section contains the uncorrected 
trace data. The corrected trace is not stored since it can be calculated from 
the uncorrected and reference traces. When this section is not included, the 
preceding section contains the uncorrected trace data. 

209+(2 x n) [END]  

 
 
 

Log Text Files 
Each time a new sweep measurement is started, the log is cleared. FS-K4 then tries to initialize the 
analyzer and will log the result, for example: 

 
Initialization 
============== 
 
Analyzer type FSEB 30+B2+B4+B5 initialized successfully. 
 

If the Carrier Search function is enabled, its results will appear next. The analyzer sweeps a span of 
twice the Frequency Tolerance, centered on the Signal Frequency specified in the Sweep Setup 
dialogue. If the peak exceeds the reference level, the reference level is increased by 10dB and the 
sweep repeated. The peak is then accurately measured using the frequency counter and marker. For 
example: 

 
Carrier search starting 
======================= 
 
  Center 100 MHz, Span 2 kHz 
  RBW 2 kHz, Reference level -15.00 dBm 
  Sweep, Max Hold x 1, result OK  
  Peak found at 50.0000661 MHz, 2.94 dBm 
 
  Sweep, ClearWrite x 1, result OK  
 
Carrier found at 149.9999939 MHz, 2.94 dBm 
 

If no Signal is found or if the Signal is outside the specified tolerances, the measurement will be aborted. 
The Reference Level and any Level Offset to be used during the Phase Noise sweep are then logged, 
for example: 

 
Ref. Level will be set to 2.94 dBm for offsets less than 10 kHz. 
Ref. Level will be set to -17.06 dBm for offsets greater than 10 kHz 
 
Level Offset is 0.00 dB 
 

Input attenuation is normally calculated to obtain a signal level of up to +5dBm at the mixer input for 
offsets greater than 10 kHz. However since the frequency response of the front end is not guaranteed to 
be flat, it is necessary to check whether any additional attenuation will be required for offsets from 10 
kHz to 100 MHz. Above this, the carrier is well outside the edges of the resolution bandwidth filter and 
not additional attenuation is required. 
 
A check is made to see if the RF Overload warning is activated with the calculated input attenuation. If it 
is activated, the attenuation is increased in 10dB steps until the overload is removed.  

 
RF Overload Check starting 
========================== 
 



FS-K4 Data Storage Format 

1108.0107.42 73 E-6 

  Input Attenuation set to 0 dB 
  Sweep, Average x 1, result *** RF Over Range ***  
  Input Attenuation set to 10 dB 
  Sweep, Average x 1, result OK  
 
Attenuation will be offset by 10 dB, in the range 10 kHz to 100 MHz 
 

The Phase Noise measurement then starts. The overall sweep is divided into one or more sub-sweeps 
depending on the specified start and stop offsets. For each sub-sweep the following information is 
logged: 
 

Start Decade Number Sub-sweep within decade 
Absolute Start Frequency Absolute Stop Frequency 
Resolution Bandwidth Video Bandwidth 
Main PLL Bandwidth Input Attenuation 
Reference level Normalization Factors 
 

In addition the analyzer’s Phase Noise Marker is used to measure at six points equally spaced across 
the sub-band and the results are listed along with the results from the sub-band and the computed 
difference. For example: 

 
Sweep 1, Start Decade = 3, Sub-band = 1 
 
  Offsets 1kHz to 10kHz relative to 149.9999939MHz 
  RBW set to 200Hz 
  PLL Bandwidth set to HIGH, FFT Filter is ON 
  Input Attenuation set to 20 dB 
  Reference level set to 2.90 dBm 
  Sweep, Average x 1, result OK  
 
  Normalization factors for Model 7 
  ---------------------------------- 
  RBW = 200Hz , => 23.01 dB 
  Kn = 1.06, => 0.25 dB 
  FLLog = 1.45 dB 
  FDLog = 1.05 dB 
  Total Correction Factor = -20.76 dB 
 
  Frequency   Level       Corrected   Relative    Phase Mkr   Delta 
  ----------  ----------  ----------  ----------  ----------  ---------- 
        1kHz   -80.89 dB  -101.65 dB  -104.59 dB  -105.79 dB     1.20 dB 
   2.8036kHz   -92.96 dB  -113.72 dB  -116.66 dB  -115.43 dB    -1.23 dB 
   4.6072kHz   -86.93 dB  -107.69 dB  -110.63 dB  -115.99 dB     5.36 dB 
   6.4108kHz   -92.96 dB  -113.72 dB  -116.66 dB  -116.23 dB    -0.43 dB 
   8.2144kHz   -92.96 dB  -113.72 dB  -116.66 dB  -116.59 dB    -0.07 dB 
       10kHz   -86.93 dB  -107.69 dB  -110.63 dB  -111.10 dB     0.47 dB 

Once the sweep is complete the following message is logged: 
 
Phase Noise measurement complete 
================================ 
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FS-K4.INI 
These contain the following groups and entries 
 
Line [Group] or Entry Value 

1 [VERSION]  

2 VERSION Software version used to write the file, enclosed in single quotes 

3 [END]  

4 [SETUP]  

5 ANALYZER { 'FSEA 20(+B2)(+B4)(+B5)' | 'FSEA 30(+B2)’ | 'FSEB 20(+B4)(+B5)' | 
'FSEB 30' | 'FSEM 20(+B4)(+B5)' | 'FSEM 30' | 'FSEK 20(+B4)(+B5)' | 
'FSEK 30' | 'FSIQ 3(+B2)' | 'FSIQ 7' | 'FSIQ 26' | 'FSIQ 40' | 'ESIB 7' |  
'ESIB 26' | 'ESIB 40' | 'FSP 3' | 'FSP 7' | 'FSP 13' | 'FSP 30' | 'FSP 40' | 
'ESPI 3' | 'ESPI 7' | 'FSU 3' | 'FSU 8' | 'FSU 26' | ‘FSU 46’ | ‘FSU 50’ |  
'FSQ 3' | ‘FSQ 8' | 'FSQ 26' } 

6 METHOD { 0 | 1 } where 0 means 'use GPIB', and 1 means 'use DDE' 

7 INITIALIZE { 0 | 1 } where 0 means 'do not initialize on start-up', and 1 means 'do 
initialize on start-up'. 

8 ADDRESS { 0 | 1 | … | 31 } 

9 DEFAULT PATH 0 Fully qualified path for Analyzer Setup files 

10 DEFAULT PATH 1 Fully qualified path for Result Data files 

11 DEFAULT PATH 2 Fully qualified path for Limit Line files 

12 GRAPHIC FORMAT 0 Bitmap value indicating color, style, and line width used to draw 
Graph border 

   Where bits 0 to 3 specify the color, bits 4 to 7 specify the Style, and 
bits 8 to 11 specify the line width. 

13 GRAPHIC FORMAT 1 Bitmap value indicating color, style, and line width used to draw 
Graph Vertical Grid 

14 GRAPHIC FORMAT 2 Bitmap value indicating color, style, and line width used to draw 
Graph Horizontal Grid 

15 GRAPHIC FORMAT 3 Bitmap value indicating color, style, and line width used to draw 
Graph Text 

16 GRAPHIC FORMAT 4 Bitmap value indicating color, style, and line width used to draw 
Graph Trace 

17 GRAPHIC FORMAT 5 Bitmap value indicating color, style, and line width used to draw 
Graph Ref. Trace 

18 GRAPHIC FORMAT 6 Bitmap value indicating color, style, and line width used to draw 
Graph Limit 

19 GRAPHIC FORMAT 7 Bitmap value indicating color, style, and line width used to draw 
Graph Normal Marker 

20 GRAPHIC FORMAT 8 Bitmap value indicating color, style, and line width used to draw 
Graph Delta Marker 

21 DDE GRAPH 0  

22 DDE SETUP 0  

23 DDE TEXT 0  

24 DDE START 0  

25 DDE STOP 0  

26 HELPFILE Name of help file 
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Line [Group] or Entry Value 

27 TMO NORMAL { 0 | 1 | … | 17 } 

Sets the normal GPIB timeout period. Default value is 12. 
0 means disabled - no timeout 
1 10 µs 
2 30 µs 
3 100 µs 
4 300 µs 
5 1 ms 
6 3 ms 
7 10 ms 
8 30 ms 
9 100 ms 
10 300 ms 
11 1 s 
12 3 s 
13 10 s 
14 30 s 
15 100 s 
16 300 s 
17 1000 s 

28 TMO SPOLL { 0 | 1 | … | 17 }  

Sets the GPIB timeout period used during serial poll operations. Default 
value is 13 

29 TMO DISPLAY { 0 | 1 | … | 17 }  

Sets the GPIB timeout period used during display update operations. Default 
value is 13 

30 TMO INIT { 0 | 1 | … | 17 }  

Sets the GPIB timeout period used during initialization operations. Default 
value is 12 

31 LOG SWEEP { 0 | -1 } where 0 means 'disable Measurement Log', and -1 means 'enable 
measurement log' 

32 [END]  

  



 

 



FS-K4 Decision and Error Messages 

1108.0107.42 77 E-6 

9 Decision and Error Messages 

The following table contains an alphabetical list of all decision and error messages that can be issued by 
FS-K4. An explanation, possible options and/or steps for error elimination are given for each message. 
 
Message Explanation 

 Error elimination 

Analyzer failed 
identification test at 
GPIB address (number) 

FS-K4 tried to identify the Analyzer type using the specified GPIB address, but there was no 
response. Either there is another device using the same address, or the Analyzer has the wrong 
bus address, or it is not connected to the GPIB, or it is not turned on. 

To fix the problem and try again 
 Check that the Analyzer is switched on, connected to the GPIB, and set to the specified bus 

address. Also verify that there are no other devices using the same address. Then choose the 
Retry button. 

To abort the Analyzer operation 
 Choose the Cancel button. 

Analyzer frequency 
range exceeded 

The frequency range of the specified files exceeds the capabilities of the specified Analyzer. It will 
not be possible to make a sweep measurement. 

To correct this problem do one of the following: 
 Modify the frequency range of the specified files before making a measurement. 

 Use a different Analyzer. 

Analyzer not found at 
GPIB address (number) 

FS-K4 tried to control the Analyzer using the specified GPIB address, but there was no response. 
Either the Analyzer has the wrong bus address, or it is not connected to the GPIB, or it is not 
turned on. 

To fix the problem and try again 
 Check that the Analyzer is switched on, connected to the GPIB, and set to the specified bus 

address. Then choose the Retry button. 

To abort the Analyzer operation 
 Choose the Cancel button. 

Analyzer not 
responding 

FS-K4 tried to control the Analyzer but there was no response. Either the Analyzer is not connected 
to the GPIB, or it is not turned on. 

To fix the problem and try again 
 Check that the Analyzer is switched on, and connected to the GPIB. Then choose the Retry 

button. 

To abort the Analyzer operation 

  Choose the Cancel button. 

Analyzer type at GPIB 
address (number) is not 
supported 

FS-K4 found an unsupported device type at the specified GPIB address. 

To fix the problem and try again 
 Choose the OK button to abort this Analyzer operation. Replace the Analyzer with one of the 

following:  

FSEA 20(+B2)(+B4)(+B5) | FSEA 30(+B2) | FSEB 20(+B4)(+B5) | FSEB 30 | 
FSEM 20(+B4)(+B5) | FSEM 30 | FSEK 20(+B4)(+B5) | FSEK 30 | FSIQ 3(+B2) | FSIQ 7 | 
FSIQ 26 | FSIQ 40 | ESIB 7 | ESIB 26 | ESIB 40 | FSP 3 | FSP 7 | FSP 13 | FSP 30 | FSP 40 | 
ESPI 3 | ESPI 7 | FSU 3 | FSU 8 | FSU 26 | FSU 46 | FSU 50 | FSQ 3 | FSQ 8 | FSQ 26, where 
the text in parentheses is optional and should only be included if the corresponding option is 
fitted to your Analyzer. Then try again. 

Analyzer type does not 
match setup 

FS-K4 found that the active Analyzer is of a different type to that specified in the Sweep Setup 
(p35). 

To correct this error do one of the following: 
 Change the Sweep Setup to select the correct Analyzer type. 
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Message Explanation 

 Error elimination 

 Change the Analyzer to match that specified in the Sweep Setup. 

Changes to Analyzer 
setup will invalidate 
results 

One or more of the changes you have made affect the way in which the Sweep measurement is 
made. Thus the measured data currently stored in memory has become invalid and will be erased. 

To continue with the new settings and erase existing results 
 Choose the OK button. 

To undo the changes and retain the existing results 
1. Choose the Cancel button. 

2. Exit the editor by choosing the Cancel button. 

DDE Link driver 
software missing 

FS-K4 was unable to find the driver software for the DDE Link. The driver files are called RSIB.DLL 
and RSDDE.DLL, and should have been installed in your C:\WINDOWS\SYSTEM directory, or 
equivalent. 

To correct this error 
 Copy the files from the C:\RSIB directory on the FSE hard disk to the C:\WINDOWS\SYSTEM 

directory. Then re-start Windows and FS-K4. 

 If the C:\RSIB directory is missing, contact your Rohde & Schwarz representative and ask for a 
firmware upgrade. Once this has been installed, re-install the FS-K4 software, by following the 
instructions on the disk label, and re-start FS-K4. 

ERROR An error condition has occurred. Please make a note of the error message and your actions 
leading up to it's appearance and report them to Rohde & Schwarz Services Ltd. 

To continue 
 Choose the OK button to continue the application. 

File already exists While saving a file, you typed the name of an existing file. 

To replace the existing file with the active file 
 Choose the Yes button. 

To retain the existing file 
1. Choose the No button. 

2. Type a different name for the active file. 

File does not exist You tried to open a file that does not exist. 

To correct this error do one of the following: 
 Make sure you typed the correct path and filename. 

 Type the name of a file that exists. 

 If a list is available, select a filename. 

Filename does not 
follow DOS 
conventions 

The name of a file or directory can have two parts: a name and an optional extension.  The two 
parts are separated by a period.  For example, MYFILE.SET is a valid filename; MYFILE is the 
name of a file, and .SET is the filename extension. 

The name can contain up to eight characters, and the extension can contain up to three 
characters. 

The name must start with either a letter or number.  It can contain any uppercase or lowercase 
characters except the following: 

Period(.) Quotation Mark (") Slash (/) Backslash (\) Brackets ([ ])  
Colon (:) Semicolon (;) Vertical Bar (|) Equal Sign (=) Comma (,) 

If you use these characters in a filename, you may get unexpected results. 

The name cannot contain any spaces. 

The following names are reserved and cannot be used for files or directories: CON, AUX, COM1, 
COM2, COM3, COM4, LPT1, LPT2, LPT3, PRN, and NUL. 
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Message Explanation 

 Error elimination 

GPIB address not 
specified 

There is no GPIB address defined for the specified Analyzer type so FS-K4 is unable to establish 
communication. 

To correct this error 
 Assign a valid bus address to the specified Analyzer type using the Analyzer (p48) command in 

the Options menu, then re-try.  
complete.  

GPIB card missing FS-K4 was unable to find a GPIB card installed in this computer and will not be able to control an 
Analyzer. 

To correct this error 
1. Install and configure a supported interface card. 

2. Re-run FS-K4. 

GPIB driver did not 
recognize the name 

FS-K4 was unable to communicate with the GPIB. 

To correct this error 
1. Run the configuration software supplied with the interface card and set all parameters to their 

default condition. 

2. Choose Retry to try again. 

To continue without GPIB capability 
 Choose Cancel. 

GPIB driver software 
missing or out-of-date 

FS-K4 was unable to find the driver software for your GPIB, or the driver does not support the 
required functionality. The driver file is called GPIB.DLL and should have been installed in your 
C:\WINDOWS\SYSTEM directory, or equivalent. 

To correct this error 
 If the driver is missing: re-install it, from the disks supplied with your GPIB card, according to 

the manufacturers instructions. Then re-start Windows and FS-K4. 

 If the driver is out-of-date: contact your GPIB card supplier and ask for the latest release of 
driver software for your card and operating system. Then install it according to the 
manufacturers instructions, and re-start Windows and FS-K4. 

Incorrect entries You specified one or more values that are outside the capabilities of the specified Analyzer type. 

To fix the problem and try again 
 Correct the specified parameters. 

 Choose the OK command button. 

Note:  Refer to the documentation supplied with your Analyzer for more information concerning 
the range of values that may be entered. 

Limit definition error A limit line definition must contain a name, and at least two samples. 

To fix the problem and try again 
1. Correct the specified parameters. 

2. Choose the OK command button. 

MEASUREMENT 
ABORTED -  
Analyzer firmware does 
not support FFT Filter 
control via GPIB 

You enabled FFT Filters for one or more sub-bands, however the version of firmware installed on 
your analyzer does not support the control of FFT Filters via the GPIB. 

Please contact your Rohde & Schwarz representative and ask for a firmware upgrade. Once this 
has been installed, FS-K4 will allowing these settings to be used. 

MEASUREMENT 
ABORTED -  
Carrier Frequency is 
outside Signal 
Frequency Tolerance 
range 

FS-K4 has found a Signal Carrier which is either lower than the Signal Frequency - Frequency 
Tolerance, or greater than the Signal Frequency + Frequency Tolerance. 

To fix this problem do one of the following 
 Increase the Frequency Tolerance range in the Sweep Setup box. 

 Modify the Signal Frequency setting in the Sweep Setup box. 
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Message Explanation 

 Error elimination 

 Adjust the signal generator to produce the desired output frequency. 

MEASUREMENT 
ABORTED -  
Max. Peak Level is 
outside Signal Level 
Tolerance range 

FS-K4 has found a Signal Carrier which is lower than the Signal Level - Level Tolerance. 

To fix this problem do one of the following 
 Increase the Level Tolerance range in the Sweep Setup box. 

 Modify the Signal Level setting in the Sweep Setup box. 

 Adjust the signal generator to produce the desired output level. 

MEASUREMENT 
ABORTED -  
No Signals found within 
Signal Frequency 
Tolerance range 

FS-K4 was unable to find any Signal Carrier. 

To fix this problem and try again 
1. Check that the signal generator is producing an output at the correct frequency and level. 

2. Check that the signal generator is connected to the Analyzer's RF INPUT. 

3. Check that the correct Signal Frequency and Level have been specified in the Sweep Setup 
box. 

4. Choose Start from the Sweep menu, to start a new measurement. 

MEASUREMENT 
ABORTED -  
Operator command 

This message simply confirms that FS-K4 has responded to the Sweep menu's Stop command. 

MEASUREMENT 
ABORTED -  
Sweep did not complete 
within expected time 
period 

The sweep took longer than expected or did not start correctly. This is usually caused by a 
firmware problem within the Analyzer. 

To fix this problem and try again 
1. Turn the analyzer off, and then back on. 

2. Wait until the analyzer has initialized, and then try making the measurement again. 

MEASUREMENT 
ABORTED -  
Sweep range exceeds 
analyzer maximum stop 
frequency 

The Signal Frequency + Maximum Offset is greater than the maximum frequency that can be 
measured by the Analyzer. 

To fix this problem and try again 
1. Reduce the Maximum Offset in the Sweep Setup box. 

2. Choose Start from the Sweep menu, to start a new measurement. 

Possible incorrect 
entries 

You specified one or more values that may be outside the capabilities of the specified Analyzer 
type. 

Some Analyzers are supplied with an extended frequency range. However it is not possible to 
determine the upper frequency limit from the model number or installed options. 

To try measuring with the programmed values 
1. Choose the OK command button. 

2. Try making a measurement by choosing Start from the Sweep menu. 

If the programmed values exceed the Analyzer’s frequency range, the measurement will be 
aborted. 

To modify the programmed values and try again 
1. Choose the Cancel command button in this message box. 

2. Correct the specified parameters. 

3. Choose the OK command button in the Sweep Setup box. 

Note:  Refer to the documentation supplied with your Analyzer for more information concerning 
the range of values that may be entered. 

Printer not selected The Print Setup dialogue was unable to initialize the selected printer. 

Some drivers such as the HP Plotter cannot be selected from FS-K4. 

To correct this error 
 Use the Printer Setup command in Print Manager's Options menu to select and configure the 
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Message Explanation 

 Error elimination 
required printer driver before printing from FS-K4. 

Reference trace is not 
compatible with new 
setup 

FS-K4 requires that the main and reference traces must contain the same frequency axis settings. 

To make reference measurements with the new setup 
1. Make a Sweep measurement with the reference signal only. 

2. Choose the Trace To Reference command from the Sweep menu to copy the new reference 
trace into the reference buffer. 

Save changes to (file 
type) (filename)? 

You quit FS-K4 or closed a file without saving changes you made to a file. 

To save the changes 
 Choose the Yes button. 

To discard the changes 
 Choose the No button. 

To continue without quitting FS-K4 or saving the changes 
 Choose the Cancel button. 

Save option menu 
changes? 

You quit FS-K4 without saving changes you made in the options menu. 

Option menu settings are stored in the FS-K4.INI file, which can be found in the main Windows 
directory. 

To save the changes 
 Choose the Yes button. 

To discard the changes 
 Choose the No button. 

Sorry, no help available 
for this subject 

 See, "Obtaining Technical Support" in the Help menu. 
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